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Support Contacts
If you encounter a problem while installing, registering, or operating this product, please make sure that you have 
read the documentation. If you cannot resolve the issue, contact your supplier or Gemalto Customer Support. 
Gemalto Customer Support operates 24 hours a day, 7 days a week. Your level of access to this service is 
governed by the support plan arrangements made between Gemalto and your organization. Please consult this 
support plan for further information about your entitlements, including the hours when telephone support is 
available to you.

Additional Documentation
The following publications are available:

• 007-013561-005 SafeNet Authentication Client 10.5 Windows (GA) User Guide

• 007-013559-007 SafeNet Authentication Client 10.5 Windows (GA) Release Notes (RN) Rev B

Contact Method Contact Information

Customer Support Portal https://supportportal.gemalto.com

Existing customers with a Technical Support Customer Portal account 
can log in to manage incidents, get the latest software upgrades, 
and access the Gemalto Knowledge Base.

Technical Support contact email technical.support@gemalto.com
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1 – Introduction
Introduction

SafeNet Authentication Client (SAC) is a middleware client that manages Gemalto’s extensive SafeNet portfolio 
of certificate-based authenticators, including eToken, IDPrime smart cards, iKey smart card, USB and software-
based devices. 

With full backward compatibility and incorporating features from previous middleware versions, SafeNet 
Authentication Client ensures complete support for all currently deployed eToken and iKey devices, as well as 
IDPrime MD and .NET smart cards.

Overview
SafeNet Authentication Client is Public Key Infrastructure (PKI) middleware that provides a secure method for 
exchanging information based on public key cryptography, enabling trusted third-party verification of user 
identities. It utilizes a system of digital certificates, Certificate Authorities, and other registration authorities that 
verify and authenticate the validity of each party involved in an internet transaction.

SafeNet Authentication Client enables the implementation of strong two-factor authentication using standard 
certificates as well as encryption and digital signing of data. Generic integration with CAPI, CNG, and PKCS#11 
security interfaces enables out-of-the-box interoperability with a variety of security applications offering secure 
web access, secure network logon, PC and data security, and secure email. PKI keys and certificates can be 
created, stored, and used securely from within hardware or software.

SafeNet Authentication Client can be deployed and updated using any standard software distribution system, 
such as Windows Group Policy Objects (GPO) or Microsoft System Management Server (SMS).

The SafeNet Authentication Client Tools application and the SafeNet Authentication Client tray icon application 
are installed with SafeNet Authentication Client, providing easy-to-use configuration tools for users and 
administrators.
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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SafeNet Authentication Client API Flow
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1 – Introduction
License Activation
SafeNet Authentication Client 10.5 is installed by default as non-licensed.

To activate the license perform the following steps:

1. Obtain a valid SAC License Key from SafeNet Customer Service.

2. Activate the license using one of the following procedures:

• Manual Activation

See the Licensing chapter in the SafeNet Authentication Client 10.5 User Guide.

• Command Line Activation

See "PROP_LICENSE_FILE Property" on page 47 (Command Line column) and Installing the MSI file 
via the Command Line on page 42.

Group Policy Object Editor

See "License Settings" on page 76 (ADM File Setting column) and Setting SafeNet Authentication Client 
Properties on page 65.

• SafeNet Authentication Client Customization Tool

You can specify the license key when creating a customized MSI Installation file.

See Using the SafeNet Authentication Client Customization Tool, step 3, on page 25.

NOTE: 

IDGo 800 Minidriver is part of the SafeNet Authentication Client 10.5 Customization Tool 
package. The usage and installation of the IDGo 800 Minidriver as a standalone component 
does not require licensing.

NOTE: 
SafeNet Authentication Client retrieves the license file (SACLicense.lic) automatically, if the license 
file is located in the following default path Windows: \ProgramData\SafeNet\SAC
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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1 – Introduction
IDPrime MD Applet 4.0
The IDPrime MD Applet 4.0 is Common Criteria certified on IDPrime MD 840 and 3840. These cards can have 
certain parameters customized in the factory with different values to the standard default profile.

The following parameters can be customized:

• Number and type of key containers

• Support of RSA 4,096-bit key containers (import operation only) - Note: The card needs to be configured 
by the SAC supported key length.

• Change PIN at first use Secure messaging in contactless mode

• PINs (#1, #3 and #4 only)

• Try Limit

• Unblock PIN (PIN#1 only)

• Policy values

• Properties

• PIN validity period

• Secure messaging in contactless mode

NOTE: 
The IDPrime MD 840 card does not support the retry counter on the Admin Key.
The recommended workaround is to set the MD 840 profile with a PUK instead of the Admin Key. 
To ensure maximum security, when using friendly mode, set the password with at least 16 random 
printable characters.
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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1 – Introduction
Number and Type of Key Containers
By default, the IDPrime MD Applet 4.0 is pre-personalized with:

• 2 X 2,048-bit CC Sign Only RSA Keys

• 2 X 1,024-bit Standard Sign and Decrypt RSA Keys

• 8 X 2,048-bit Standard Sign and Decrypt RSA Keys

• 2 X 256-bit Standard Sign and Decrypt EC Keys

API Adjustments
This table below provides a high-level description of the adjustments that can be made to the Standard and 
Extended PKCS#11 API to work with IDPrime MD CC devices. For more detailed information, see the code 
samples.

Standard PKCS#11 API Extended PKCS#11 API

The C_InitToken function must receive the current 
Security Officer (SO) Password

The C_InitToken function must receive the current 
Security Officer (SO) Password

When the C_InitToken function is called, you can 
enable linked mode on the IDPrime MD CC device by 
using the following registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\Policies\
SafeNet\Authentication\SAC\Init - 
LinkMode (DWORD)

The registry key must be set to 1 and the device must 
be in the factory initialized state (Admin key = 48 zeros, 
PUK = 6 zeros)

To revert a device back to unlinked mode after it was 
initialized in linked mode, use the PKCS#11 Extended 
API, or by using SAC Tools initialization process.

To initialize the IDPrime MD CC device, the ETCKA_CC 
attribute must be set to CK_TRUE.

To initialize a device in linked mode, set the 
ETCKA_IDP_CC_LINK attribute to 1.

To pass the current Digital Signature PUK value, use the 
ETCKA_IDP_CURRENT_PUK attribute.

To revert a device back to unlinked mode after it was initialized 
in linked mode, set the ETCKA_IDP_CC_LINK attribute to 0 
and use the ETCKA_PUK attribute to set the new Digital 
Signature PUK value.

If a device is not configured to use linked mode, the 
C_InitToken function ignores the Digital Signature 
PUK and Digital Signature PIN.

If a device is not configured to use linked mode, use
the ETCKA_PUK attribute to set the new Digital Signature 
PUK value.

After the device has been initialized in linked mode, the 
C_InitPIN function initializes the Digital Signature 
PIN and the User PIN. Both PIN's are set to the same 
value. 

The C_SetPIN function used with the CKU_SO flag 
changes both the Administrator PIN and Digital 
Signature PUK to a new value. See the SafeNet 
Authentication Client User Guide for details on Friendly 
Admin Password.

The C_SetPIN function used with the CKU_USER flag 
changes both the User PIN and Digital Signature PIN to 
a new value.

If the device is initialized to use linked mode, the C_InitPIN 
function and C_SetPIN function behaves the same as 
described in the Standard PKCS#11 section.
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Security Recommendations

Ensuring a Secured SAC Environment
This section provides short guidelines on how to maintain a safe PC computer environment. The information is 
based on the security recommendations defined by Microsoft.

Windows Malware Prevention

Up-to-date security software is the best way to help protect your computer from a malware attack. Microsoft 
provides security software that is regularly updated to protect against the latest threats. More details are to be 
found here:

https://www.microsoft.com/en-us/security/portal/mmWinodpc/shared/prevention.aspx

Enable Automatic Windows Updates

Automatic Windows updates ensure that you are running software with the latest security enhancements. When 
new updates are available, Windows sends you a notification. Accept the updates with a click and they download 
and install automatically.

Anti-Virus Software

Make sure to choose an effective Anti-Virus/Malware software to protect your client machines. It is essential to 
keep the Anti-Virus/Malware software updated.

Install the SAC Package Only from the Official Gemalto Site

https://serviceportal.safenet-inc.com/eservice_ENU/start.swe?SWECmd=Start&SWEHo=serviceportal.safenet-
inc.com

To ensure that the Gemalto certificate is being utilized:

1. After downloading the package (MSI/EXE), right click on the file and select Properties

2. In the Properties window, click the Digital Signatures tab and verify that the Gemalto signature is listed.
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3. Select the Gemalto signature and click Details.

4. In the Digital Signature Details window, General tab, verify that the text The Digital Signature is OK is 
displayed. 
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Malware Awareness

Malware authors use several common tricks to install their malicious software on your PC. Understanding the 
most common ways they do this can help you stay protected.

• Email – Malware often arrives on your PC in an email attachment. You should never open an attachment 
from someone you don’t know or if an email looks suspicious. Instant messages and requests for file 
transfers can also spread malware.

• Websites – Never open links to webpages that you don’t recognize or that are sent from people you 
don’t know. Malicious websites can install malware on your PC when you visit them.

• Use caution – If you view a website that doesn’t look quite right, or unexpected things happen when you 
visit, close your browser, download the latest updates for your security software and run a quick scan on 
your PC.

• Pirated software – Malware is often bundled together with pirated software. When you install the pirated 
software you may also install malware. 

• Social engineering – Malware authors often try and trick you into doing what they want. This can be 
clicking or opening a file because it looks legitimate, paying money to unlock your PC or visiting a 
malicious webpage. These deceptive appeals are known as social engineering.

• Passwords – Attackers may try to guess your Windows account or other passwords. This is why you 
should always use a password that can’t be guessed easily. A strong password has at least eight 
characters and includes letters, numbers, and symbols. 

• Removable drives – Some types of malware, such as worms, can spread by copying themselves to any 
USB flash drives or other removable drives that are connected to your computer. Always be careful when 
sharing removable drives, and make sure you scan them. 

Limit User Privileges

Many malware threats need full access to your computer to run properly. Windows 10, Windows 8.1, Windows 7, 
and Windows Vista use User Account Control (UAC) to limit what a program can do without your permission.

This means you will be notified if any software or application tries to make any changes to your system. It can 
also help stop malware and unwanted software from installing themselves or changing the way your computer 
works.

Windows 10 Elevated Security

In Windows 10 and Windows Server 2016 you should use Credential Guard to enhance security. 

See more details at:

https://technet.microsoft.com/en-us/itpro/windows/keep-secure/credential-guard
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Additional Environment Recommendations

The following actions will help keep your information as safe as possible:

• Enable Windows Defender

• Control access to your computer by locking your screen after a period of inactivity.

• Set up secure file sharing.

• Make sure you're running only those sharing services that you really need.

• Use a local account - This provides greater security than, for example, a Microsoft account which, if 
hacked, it will enable remote logon to your applications.

• Enable secure boot and UEFI, instead of legacy BIOS.

• Disable Flash and Java. These frequently report security vulnerabilities.

• Encrypt hard drive. This will protect your data if your computer accessed directly. 

SAC Configuration Recommendations
The following recommendations will help you maintain a secured SAC environment as well as keep your 
information as safe as possible:

• Common SAC configuration: The preferred mechanism to use when deploying SAC configuration 
policies through the company domain computers, is to use the domain GPO with SAC ADM and ADMX 
files. For more information, refer to Chapter 7: SafeNet Authentication Client Settings (page 56).

• Common UI restrictions: System administrators can hide/disable an unwanted UI option/s and 
configure the non overridable UI parameters. For more information, refer to Chapter 8: SafeNet 
Authentication Client Tools UI Initialization Settings (page 82), Chapter 8: SafeNet Authentication Client 
Tools UI Settings (page 86) and Chapter 8: SafeNet Authentication Client Tools UI Access Control List 
(page 105).

• User/Administrator smart card password protection: To avoid password leakage, we recommend the 
following:

• Use PIN Pad readers - user passwords do not pass through a computers memory when using a PIN 
Pad reader.

• Use devices configured to support secured messaging - secured messaging protects the transfer 
of data between the middleware and the device.

• Protect the device from unauthorized usage: 

• Ensure the device is disconnected when not in use.

• Enable the CAPI Password Timeout option - this requires re-authenticating (See Chapter 8: CAPI 
Settings (page 92)) 

• Using the Single Logon option is less secured and is therefore not recommended (See the Single 
Logon registry key in Chapter 8: General Settings (page 68)) 

• Configure restrictive password policies: 

• Change the default administrator password. For more information, see the SafeNet Authentication 
Client User Guide - Chapter 4 - Token Management.

• For devices running the eToken applet, change the default Initialization Key (this protects devices 
from unwanted initialization). For more information, see the SafeNet Authentication Client User 
Guide.

NOTE: 
SAC 10.5 is compliant with Windows 10 Microsoft Credential Guard and Windows 8.1 Local Security 
Authority (LSA) with code integrity enabled.
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• If the device was enrolled by an administrator (on behalf of a user), use the ‘Token password must be 
changed on first logon’ option. For more information, see the SafeNet Authentication Client User 
Guide.

• For supported devices use the on-board password quality settings (use the ‘Enforce password quality 
settings’ option). For more information, see the SafeNet Authentication Client User Guide.

• The recommended password strength is: 

• User PIN should include at least 8 characters of different types.

• Admin PIN should include at least 16 characters of different character types.

• The Friendly Admin Password should include at least 16 characters of different types (See the 
SafeNet Authentication Client User Guide for more details on the Friendly Admin Password) 

• Digital Signature PUK, when using a friendly name, this should include at least 16 characters of 
different types.

• For devices running the IDPrime applet, the 3DES random key may be used instead of the 
administrator password.

• Use the password validity period combined with password history options.

For more information on how to configure password policy settings, refer to ‘Chapter 8: Token Password Quality 
Settings (page 99), the Token Initialization chapter in the SafeNet Authentication Client User Guide and the 
Password Recommendations section in the SafeNet Authentication Client Release Notes.

• Configure restrictive cryptographic policies: 

To allow organizations to enforce restrictive cryptographic policies when using SafeNet / Gemalto 
security devices (smart cards and USB tokens), the following policies were updated:

• Deprecated Cryptographic Algorithms and Features Policy

• Key Management Policy

The motivation behind these policy updates:

Legacy cryptographic schemes can cause organizations to fail current compliance requirements or 
expose cryptographic weakness associated with deprecated algorithms and mechanisms. 
Changes have been made to the default SAC configuration to disallow the usage of cryptographic 
algorithms, or protocols, that are now considered to be weak.

From SAC 10.5, the default settings were updated to eliminate revealing sensitive data:

• The creation, generation and usage of exportable symmetric keys are blocked.

• The unwrapping and wrapping of asymmetric/symmetric private keys is blocked.

• Preventing legacy algorithms from being used by adding a key wrapping policy that enforces the 
usage of only GCM and CCM modes of operation for symmetric encryption, and PKCS#1 v2.1 
padding for RSA encryption.
GCM or CCM modes are used for wrap/unwrap operations using the session wrapping key. All other 
modes are blocked.

NOTE: 

Character types include upper case, lower case, numbers, and special characters.
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• Legacy and obsolete algorithms are blocked - these cryptographic algorithms conform to the National 
Institute of Standards and Technology (NIST), preventing third-party applications from using legacy or 
obsolete algorithms..

For more information, refer to Chapter 8: Security Settings (page 109).

• Create symmetric key objects using PKCS#11:

As part of SafeNet Authentication Client security enhancement campaign, the following was performed 
in SAC 10.5:

• Protected memory was used when working with the private cache between PKCS#11 API calls. 
Private cache is unlocked to retrieve data and then locked immediately after retrieving the data to 
ensure that there is no sensitive data in the private cache. This ensures that the key cannot be 
revealed in plain text.

• Sensitive data is securely zeroed prior to freeing up the memory.

• AES and Generic symmetric key files were created with Secured Messaging (SM) protection so 
that the Microsoft smart card transport layer does not contain any APDU data with plain symmetric 
key material. 

• For Secure Messaging (SM) to support the AES/3DES and Generic symmetric keys in SAC 10.5, 
the keys must be created on an eToken Java device that is initialized in FIPS/CC mode. Applying 
SM to symmetric keys changes the object format on the smart card, resulting in the keys not being 
backward compatible.

• Keys that are created with previous SAC versions or on eToken Java devices which are formatted 
in non-FIPS/CC mode will not be protected by SM.

AES/3DES keys that are created using the CKA_SENSITIVE = TRUE and CKA_EXTRACTABLE = 
FALSE attributes are backward compatible (BS Object keys).

NOTE: 
Once a restrictive policy has been set, the use of SafeNet Authentication Client with the above 
algorithms will be blocked. This might have implications on the way in which the third-party's 
applications currently work. Administrators must make sure that the third-party applications used by 
the organization are configured accordingly and do no use one of the algorithms listed above, as 
they will be blocked.

NOTE: 
As of SAC 10.5, the creation, generation and usage of exportable symmetric keys are blocked. For 
more information, refer to Chapter 8: Security Settings (page 109).
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Customization

The SafeNet Authentication Client (SAC) installation features and the graphic user interface provided by Gemalto 
can be customized for your installation.

Customization Overview
You can customize the following SafeNet Authentication Client 10.5 (GA) features:

• Product name, which appears in the installation wizard, the Add/Remove program, and the About 
window

• Destination folder

• URL of the support link in the Add/Remove program

• License string

• SafeNet Authentication Client and IDGo 800 features to be installed

• Policy settings

• MSI Signing settings

• Window banners

NOTE: 
• .Net Framework 3.5 or higher is required on all operating systems when running the SafeNet 

Authentication Client Customization Tool.
• For backward compatibility with Gemalto IDGo 800 PKCS#11 and Minidriver deployments, 

refer to the section: Compatibility with IDGo 800 Minidriver and PKCS#11 below.
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Compatibility with IDGo 800 Minidriver and PKCS#11
SAC 10.5 Customization Tool enables you to generate an .msi file, which contains IDGo 800 Minidriver and IDGo 
800 PKCS#11 proxy.

For details on the compatibility of IDGo 800 with SAC and different use cases, see the SafeNet Authentication 
Client 10.1 Planning Guide.

Configuring IDGo 800 Minidriver Only

Selecting the IDGo 800 Minidriver check-box in the Features to install list will generate an .msi file that contains 
only the Gemalto IDGo 800 Minidriver. This option disables all other features in the list, except for the IDGo 800 
PKCS#11 check-box.

When selecting the IDGo 800 Minidriver check-box, the following IDGo 800 Minidriver binary files are installed:

Dll File Description

axaltocm.dll Installed in the System32 folder.

axaltocm.dll Installed in the SysWOW64 folder.
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Configuring IDGo 800 PKCS#11 for Backward Compatibility

The IDGo 800 PKCS#11 feature is used by Gemalto customers that have existing applications that use IDGo 800 
PKCS#11 and have a dependency on the location of IDGo 800 PKCS#11 dll file. Selecting the IDGo 800 
PKCS#11 check-box in addition to the IDGo 800 Minidriver check-box enables other features in the list, such as 
SAC Tools and SAC Monitor.

Selecting the IDGo 800 PKCS#11 together with SAC features enables Gemalto customers with existing 
applications that depend on it to seamlessly migrate to SAC without breaking compatibility of these applications.

When selecting the IDGo 800 Compatible Mode check-boxes, the following dll files are installed under 
C:\Program Files (x86)\Gemalto\IDGo 800 PKCS#11:

Dll File Description

IDPrimePKCS11.dll x32 PKCS#11 library stub for Gemalto IDPrime cards.

IDPrimePKCS1164.dll x64 PKCS#11 library stub for Gemalto IDPrime cards.
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Installing IDGo 800 Minidriver and SafeNet Authentication Client 
eToken Features

To work with both IDGo 800 Minidriver and SafeNet Authentication Client eToken, select the options as displayed 
in the image below.

Working in this mode ensures that the certificates on IDPrime devices will use Microsoft Smart Card CSP and the 
certificates on eToken devices will use SafeNet CSP.
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Installing the SafeNet Authentication Client Customization 
Tool

Before installing SafeNet Authentication Client, install the SafeNet Authentication Client Customization Tool.

To install the SafeNet Authentication Client Customization Tool:

1. Double-click SACCustomizationPackage-10.5.msi.

The SafeNet Authentication Client Customization Package Installation Wizard opens.

2. Click Next.

The License Agreement is displayed.

3. Read the license agreement, and select the option, I accept the license agreement.

4. Click Next.

NOTE: 
Only users that have Domain Admin Credentials may use the Customization Tool to create MSI files.
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The Destination Folder window opens, displaying the default installation folder.

5. You can click Browse to select a different destination folder, or install the Customization Tool’s SACAdmin 
folder into the default folder:
C:\Program Files\SafeNet\Authentication\

The Ready to Install the Program window opens.

6. Click Install to start the installation.

When the installation is complete, the SafeNet Authentication Client Customization Package has been 
successfully installed window opens.

NOTE: 
If an application from the SafeNet Authentication line of products, or an eToken legacy product, is 
already installed, we recommend that the destination folder not be changed.
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7. Click Finish to exit the wizard.

Using the SafeNet Authentication Client Customization Tool
After installing the SafeNet Authentication Client Customization Package, customize the appropriate features.

To use the Customization Tool:

1. From the Windows Start menu, select Programs > SafeNet > SACAdmin > SAC Customization Tool.

The SafeNet Authentication Client Customization Tool opens to the General Settings tab.

2. To open a project you already saved, select File > Open, and browse to the xml file of an existing project.
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3. You can replace the following items:

• Product Name: enter the relevant product name (the default value is SafeNet Authentication Client 
10.5).

• Destination Folder: the path to be used by the SafeNet Authentication Client Customization Tool 
when no other SafeNet product has been installed on the client computer

• Support URL: the URL to be displayed in the Windows Add/Remove Programs support link (the 
default value is http://www.safenet-inc.com/authentication).

• Language: select the language in which SafeNet Authentication Client will be installed.

• License String: either copy and paste a license into the box, or click Load from File, and browse to 
the .lic file containing the SafeNet Authentication Client license.

4. In the left column, select the Features to Install tab.

The Features to Install window opens with the default SAC installation features selected.

5. The features may be customized by changing the editable check-boxes. 

NOTE: 

If a language other than English is selected, the language option is disabled (grayed out) 
during the installation process. SAC is installed in the language chosen here.

NOTE: 
• When using eToken Devices it is recommended to check the eToken CAPI and SafeNet Key 

Storage Provider check-boxes. 
• In order to work with SafeNet Network Logon the eToken SAPI check-box must be checked.
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6. In the left column, select the Policy Settings tab.

The Policy Settings window opens.

7. You can override the application’s default values by changing the configuration properties to be written to the 
registry keys. These new values are saved in 
HKEY_LOCAL_MACHINE/SOFTWARE/Policies/SafeNet/Authentication/SAC.

For more information, see Chapter 8: Configuration Properties, on page 65.

NOTE: 
When installing only IDGo 800 Minidriver, the Policy Settings feature are not applicable.
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For each setting to be changed, expand the appropriate node, select the setting, and change its value.

NOTE: 
Not all policy settings are supported by IDPrime MD cards. For more details see Chapter 8: 
“Configuration Properties” on page 65.
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8. In the left column, select the MSI Signing tab.

The MSI Signing window opens.

9. To sign the installation file, select Sign MSI, and complete the enabled fields. These may include:

• Signing Method (P12, Smartcard or HSM)

• Certificate Path

• Provider Name

• Key Container Name

10. In the left column, select the Graphics tab.

NOTE: 
• Ensure that a Code Signing certificate is used when using the MSI signing feature.
• .msi files are now signed using the SHA 2 algorithm.
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The Graphics window opens.

The following graphics can be replaced:

• Upper Banner for SAC Tools - (File name: SACTopLogo.png, Properties: Dimensions - 764X142 
pixels, Bit Depth - 24)

• Lower Banner for SAC Tools - (File name: SACBottomLogo.png, Properties: Dimensions - 764X76 
pixels, Bit Depth - 24)

• Upper banner for small SAC windows - (File name: SACLogo.png, Properties: Dimensions - 506X65 
pixels, Bit Depth - 32)

11. To change a banner, click Browse, and select the graphic file required.

12. To save the customized settings, select File > Save As, and enter a name for the project.

NOTE: 
When installing only IDGo 800 Minidriver, the Graphics feature is not applicable.

NOTE: 
All banner formats must be in PNG format.

NOTE: 
• The customized settings are saved as an xml file.
• By default, project folders are saved in the following location: My 

Documents\SafeNet\Authentication\SAC\[ProfileName]
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Features to Install
This section covers a few SafeNet Authentication Client Customization Tool installation features.

For more details on what binary files are installed and their location, see Chapter 5: “SafeNet Authentication 
Client Binary Files” on page 36.

Services 

Installs SafeNet Authentication Client Monitor (Tray icon). All check-boxes are selected and shaded.

If the above options are selected, the following files are installed:

• SACSRV.exe

• SACMonitor.exe

Applications

Installs the SAC Tools application (Middleware).

If the above options are selected, the following files are installed:

• SACTools.exe

• SACMonitor.exe

eToken Engines

Installs token engines to support Java and CardOS devices. The following check-boxes are selected and shaded:

• Token Engines

• eTokenDevices

• eTokenJava
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If the above options are selected, the following files are installed:

• cardosTokenEngine.dll - CardOS token engine

• IDPrimeTokenEngine.dll - IDPrime token/card engine

• iKeytokenEngine.dll - iKey token engine

• etvTokenEngine.dll - SafeNet Virtual Token engine

Generating a Customized MSI Installation File

After the appropriate features are customized, generate an installation file.

To generate a customized installation file:

1. Open the SAC Customization Tool.

See "Using the SafeNet Authentication Client Customization Tool" on page 24.

2. Select File > Open.

3. Browse to the xml file in the folder of an existing project, and click Open.

The saved project opens.

4. Select Actions > Generate MSI.

An information window is displayed, informing you that the MSI installation files have been generated.

5. Click OK to close the window.

The project folder contains two customized MSI files:

• A file named <Project Name>-x32-10.5.msi for 32-bit installations

NOTE: 
Generating an MSI file can be performed with administrator privileges only.

NOTE: 
• By default, project folders are saved in the following location: 

My Documents\SafeNet\Authentication\SAC
• SAC 10.5 does not support legacy GA configuration profiles.
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• A file named <Project Name>-x64-10.5.msi for 64-bit installations

Installing the Customized Application
After the .msi installation file is generated, use it to install the application with its customized properties and 
features.

To install the customized application:

1. Log on as an administrator.

2. Close all applications.

3. Browse to the folder of the customized project saved in Features to Install on page 30.

4. Double-click the appropriate msi file:

• <Project Name>-x32-10.5.msi (for 32-bit installations)

• <Project Name>-x64-10.5.msi (for 64-bit installations)

where <Project Name> is the name of the customized project.

The Installation Wizard runs.

5. Follow the wizard until the installation is complete, and a confirmation message is displayed.

6. Click Finish to complete the installation.

NOTE: 
By default, project folders are saved in the following location: 
My Documents\SafeNet\Authentication\SAC
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Upgrade

It is recommended that eToken PKI Client, BSec, and earlier versions of SafeNet Authentication Client be 
upgraded to the latest version on each computer that uses a SafeNet eToken, iKey token, or SafeNet smartcard. 
Local administrator rights are required to upgrade SafeNet Authentication Client.

Upgrading Using the SafeNet Authentication Client .msi File

To upgrade from earlier versions of SafeNet Authentication Client using the msi file:

• On a 32-bit system, run SafeNetAuthenticationClient-x32-10.5.msi.

• On a 64-bit system, run SafeNetAuthenticationClient-x64-10.5.msi.

Upgrading from Versions Earlier than SAC 9.0

Legacy versions of SafeNet Authentication Client, earlier than 9.0 must be uninstalled before installing SafeNet 
Authentication Client 10.5.

Upgrading from SafeNet Authentication Client 9.0

You can upgrade from SafeNet Authentication Client 9.0 to 10.5 using the MSI file wizard installation, or by using 
the command line installation. See Installing the MSI file via the Command Line on page 42.

While running the wizard, be sure to select Use the existing configuration settings parameter on the 
installation wizard Interface Language window. This will save the configuration settings that were detected from 
the previous version.

NOTE: 
• You must restart your computer when the upgrade procedure completes. When upgrading via 

the command line using the /qn parameter, your computer is restarted automatically.
• When upgrading from previous versions of SAC, it is recommended that you save feature 

settings from the previous versions. If not, then uninstall and install SAC 10.5 with the new 
feature list.

NOTE: 

Ensure that all SafeNet Authentication Client applications are closed before upgrading, 
installing, or uninstalling SafeNet Authentication Client.
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Installation

Follow the installation procedures below to install SafeNet Authentication Client. Local administrator rights are 
required to install or uninstall SafeNet Authentication Client.

To customize the user interface and the features to be installed, see Chapter 3: Customization, on page 18.

NOTE: 
• When using an MSI file to install on Windows 7, do not run the installation from the Desktop 

folder. To ensure a successful installation, run the installation from another location on your 
computer.

• Systems later than Windows 7 and Window 2008 R2, the total number of readers is limited to 
10 from among: iKey readers, eToken readers, third-party readers, and reader emulations.

Firefox Settings:
• After installing SAC 10.5, ensure that the Gemalto PKCS#11 module does not exit in the 

Firefox security settings.

NOTE: 
• When installing SafeNet Authentication Client on a computer with IDGo 800 Minidriver, IDGo 

800 Minidriver must be uninstalled before installing SAC 10.5.
• If IDGo 800 PKCS#11 is installed, be sure to remove it before installing SAC 10.5.
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Installation Files
The software package provided by SafeNet includes files for installing or upgrading to SafeNet Authentication 
Client 10.5.

The following installation and documentation files are provided:

File Environm
ent Description

Windows

SafeNetAuthenticationClient-x32-
10.5.msi

32-bit Installs SafeNet Authentication Client 10.5, and upgrades from 
earlier versions of SafeNet Authentication Client.

SafeNetAuthenticationClient-x64-
10.5.msi

64-bit

SACCustomizationPackage-
10.5.msi

32-bit
64-bit

Installs SafeNet Authentication Client 10.5 Customization 
Package.

Use to customize SafeNet Authentication Client installation with 
non-default settings. 

If a previous version of the Customization package exists, 
uninstall the previous version, and then install the new version.

Documentation Files

007-013559-007_SafeNet 
Authentication Client_ 
10.5_Windows_GA_RN_Revision B

SafeNet Authentication Client 10.5 Release Notes for Windows.

Read before installation for last minute updates that may affect 
installation; contains important information such as resolved and 
known issues and troubleshooting.

007-013561-005_ SafeNet 
Authentication Client 
10.5_Windows_User 
Guide_Revision A

SafeNet Authentication Client 10.5 User Guide for Windows.
Provides detailed information for the user and system 
administrator regarding the use of SafeNet Authentication Client.

007-013560-005_SafeNet 
Authentication Client 
10.5_Windows_ Administrator 
Guide_Revision A

SafeNet Authentication Client 10.5 Administrator Guide for 
Windows (this document).

Provides detailed information for the system administrator 
regarding the installation, configuration, maintenance, and 
management of SafeNet Authentication Client.
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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SafeNet Authentication Client Binary Files
After installing SafeNet Authentication Client, all binary data (compiled programs, images, media and 
compressed files) is saved in: C:\Program Files\SafeNet\Authentication\SAC.

The following folders and files exist under C:\Program Files\SafeNet\Authentication\SAC:

Folder/File Folder Contents 
(.exe, .dll, .reg, .iso files) 

Description

Install • pki_defaults.reg Default registry file. Double click the 
pki_defaults.reg file to change SAC 
configuration back to the default 
configuration.

ISO • Default.iso Default ISO for eToken 7300 devices.

LogoImages • SACBottomLogo.png

• SACLogo.png

• SACTopLogo.png

Contains SAC Logo image files. These 
files may be customized using the 
SafeNet Authentication Client 
Customization Tool.

x32 • Language support packages (e.g. cs-CZ, fr-CA, etc.) These folders contain Windows x32-bit 
and x64-bit related DLL’s and 
packages.

Note: 
For x64-bit installations, both directories 
(x32 and x64) are created. All x64-bit 
binaries are located in the x64 folder 
and x32-bit binaries are located in the 
x32 folder.

All .exe files (applications) are located 
in the x64 folder only.
If a custom installation is performed 
using the SAC Customization Tool, 
additional .exe files will be shown in 
either the x32 or x64 folders.

x64 • cardosTokenEngine.dll- installs the CardOS token 
engine. This file is the main SAC dll file, which 
contains the majority of SAC codes and the eToken 
java engine (required for all devices).

• eTokenHID.dll - this file supports HID devices (only 
required for devices that are in HID mode).

• etvTokenEngine.dll - installs the SafeNet Virtual 
Token engine.

• IDPrimeTokenEngine.dllI - installs the DPrime 
token/card engine.

• iKeyTokenEngine.dll - installs the iKey token engine.

• ManageReaders.exe - this application manages 
reader settings (uses eTCoreInst.dll).

• RegistereTokenVirtual.exe - this application 
manages the registration of SafeNet Virtual Tokens.

• SACLog.dll - manages all application logs and DLL’s 
(The ‘Enable logging’ options must be selected).

• SACMonitor.exe - Installs the SafeNet 
Authentication Client application.

• SACSRV.exe - Installs SafeNet Authentication Client 
services

• SACTools.exe - Installs SACUI.dll

App-RTE SafeNet Authentication Client icon

SACHelp SafeNet Authentication Client User Guide This file opens when clicking the Help 
icon in SAC Tools.
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System32 and SysWOW64 Folders

All SafeNet Authentication Client DLL files that exist in the System32 folder are compiled as x64-bit.

All SafeNet Authentication Client DLL files in the SysWOW64 folder are compiled as x32-bit.

The following binaries are installed in both the System32 and SysWOW64 folders:

Installation Configurations
SafeNet Authentication Client can be installed with the following configurations:

Dll File Description

eTPKCS11.dll Installs the PKCS#11 wrapper that supports both eToken and IDPrime cards.

eTCAPI.dll Installs and supports CAPI security interface.

eTCoreInst.dll A custom dll that installs eToken drivers and adds Smart Card reader device nodes.

SNSCKSP.dll Supports CNG KSP security interface.

eTOKCSP.dll Supports CAPI CSP security interface.

NOTE: 
• For 64-bit installations, both the C:\Windows\System32 folder and C:\Windows\SysWOW64 

folder are created and all the 64-bit binaries are located in the System32 folder and all 32-bit 
binaries are located in the SysWOW64 folder.

• For 32-bit installations: Only the C:\Windows\System32 folder is created and only the 32-bit 
binaries are located in this folder.

• There is an option available that allows checking SAC binary signatures via the SafeNet 
Authentication Client User Interface (About Window). For more information, refer to the 
SafeNet Authentication Client User Guide.

Configuration Description Installation Steps

Typical SafeNet 
Authentication Client 
Installation

Typical - installs the most common 
application features.

• Install SafeNet Authentication Client. When 
using the installation wizard, select the 
Typical Configuration option.

Custom SafeNet 
Authentication Client 
Installation

Custom - installs only the application 
features you select.

• Install SafeNet Authentication Client using 
the installation wizard, and select the 
Custom option.
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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Installing SafeNet Authentication Client on Windows (MSI)
Use the SafeNet Authentication Client Installation Wizard to install the application with its default properties and 
features.

The components that can be set using the wizard are:

• Language: the language in which the SafeNet Authentication Client user interface is displayed

• Destination folder: the installation library for this and all future SafeNet authentication product 
applications

• Typical: installs the most common application features.

• Custom: installs only the application features you select.

To install via the installation wizard:

1. Log on as an administrator.

2. Close all applications.

3. Double-click the appropriate file:

• SafeNetAuthenticationClient-x32-10.5.msi (32-bit)

• SafeNetAuthenticationClient-x64-10.5.msi (64-bit)

The SafeNet Authentication Client Installation Wizard opens.

4. Click Next.

NOTE: 
Ensure that SafeNet Authentication Client applications are closed before upgrading, installing, or 
uninstalling SafeNet Authentication Client.
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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The Interface Language window is displayed.

 

5. From the dropdown list, select the language in which the SafeNet Authentication Client screens will appear.

6. If configuration settings are detected from a previous version, you can select Use the existing 
configuration settings.

7. Click Next. 

The End-User License Agreement is displayed.

8. Read the license agreement, and select the option, I accept the license agreement.

9. Click Next.

NOTE:
If configuration settings have been saved from a previous SafeNet Authentication Client installation, 
an option is displayed to use the existing settings. 
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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The Destination Folder window opens, displaying the default installation folder.

10. You can click Change to select a different destination folder, or install the SAC application into the default 
folder:
C:\Program Files\SafeNet\Authentication\

This folder will be used as the installation library for all future SafeNet Authentication applications.

11. Click Next.

The Setup Type window opens.

12. Select one of the following:

• Typical: installs the most common application features (recommended)

• Custom: installs only the application features you select.

NOTE: 
If an application from the SafeNet Authentication line of products, or an eToken legacy product, is 
already installed, we recommend that the destination folder not be changed.
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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13. If you select Custom, click Next.

The Custom Installation Type window opens.

14. Use this window to enable or disable specific features. Some features cannot be disabled, as they are 
mandatory for the installation.

15. If you select Typical, click Next, and then click Install to proceed with the installation.

The installation proceeds.

 

When the installation is complete, a confirmation message is displayed.
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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16. Click Finish to complete the installation.

Installing the MSI file via the Command Line

Command line installation gives the administrator full control of installation properties and features.

The SafeNet Authentication Client command line installation uses the standard Windows Installer msiexec 
syntax:

• for 32-bit systems:
msiexec /i SafeNetAuthenticationClient-x32-10.5.msi

• for 64-bit systems:
msiexec /i SafeNetAuthenticationClient-x64-10.5.msi

To install via the command line:

1. Log on as an administrator.

2. Close all applications.

3. To open the Command Prompt window, do one of the following, depending on your operating system:

• From the Windows taskbar, select Start > Programs > Accessories > Command Prompt.

• Right-click Command Prompt, select Run as, and set the user to administrator.

4. Type the msiexec command with the appropriate parameters, properties and feature settings, as described 
in this chapter.

NOTE: 
Ensure that SafeNet Authentication Client applications are closed before upgrading, installing, or 
uninstalling SafeNet Authentication Client.
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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Installing in Silent Mode
Installing via the command line enables the administrator to define a silent mode installation in addition to 
optional property settings.

To run the installation in silent mode with no user interface, add /qn to the end of the msiexec command:

msiexec /i [msi file] /qn

Setting Application Properties via the Command Line
During a command line installation, the administrator can override the application’s default values by including 
specific properties, and assigning each a value. These new values are saved in 
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC.
For more information, see Chapter 8: Application Properties Hierarchy, on page 65.

Properties can be set during installation only, and not during repair.

To set properties during installation, use the following command format:

• For 32-bit systems:
msiexec /i SafeNetAuthenticationClient-x32-10.5.msi PROPERTY=VALUE 
PROPERTY=VALUE /qb

• For 64-bit systems:
msiexec /i SafeNetAuthenticationClient-x64-10.5.msi PROPERTY=VALUE 
PROPERTY=VALUE /qb

where

• PROPERTY is the name of a configurable property, often identified by the prefix PROP_

• VALUE is the value assigned to the property

See the Command Line Installation Properties tableon page 44 for the list of properties that can be set during 
installation.

Some properties are stored as registry values and can be set or modified after installation. These properties are 
described in the General Settings section on page 68.

Some properties can be set during a command line installation only, and cannot be modified afterwards. These 
properties are described in the Installation-Only Properties sectionon page 44.

NOTE: 
To display a basic installation user interface, use the /qb parameter.

Example: To install the Spanish version of SafeNet Authentication Client 
in a 32-bit system, with the SAC Tools Advanced Mode setting disabled, 
all registry keys to be cleared automatically upon uninstall, and all other 
properties assigned their default values, type the following command:

msiexec /i SafeNetAuthenticationClient-x32-10.5.msi
ET_LANG_NAME=Spanish
PROP_ADVANCED_VIEW=0
PROP_CLEAR_REG=1 /qb
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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Command Line Installation Properties

Deprecated Command Line Installation Properties

Installation-Only Properties

The following properties, unless stated otherwise, can be set during command line installation only, and cannot 
be modified afterwards:

Property Description

READER_COUNT on page 46

PROP_FAKEREADER on page 46

READERS on page 47

PROP_LICENSE_FILE on page 47

PROP_REG_FILE on page 47

Property Description

ET_LANG_NAME on page 45

KSP_ENABLED on page 45

PROP_ADVANCED_VIEW on page 82

PROP_CLEAR_REG on page 46

PROP_EXPLORER_DEFENROL on page 94

PROP_PCSCSLOTS on page 71

PROP_PQ_HISTORYSIZE on page 100

PROP_PQ_MAXAGE on page 99

PROP_PQ_MINAGE on page 99

PROP_PQ_MINLEN on page 99

PROP_PQ_MIXCHARS on page 100

PROP_PQ_WARNPERIOD on page 100

PROP_PROPAGATECACER on page 95

PROP_PROPAGATEUSERCER on page 95

PROP_SINGLELOGON on page 70

PROP_SINGLELOGONTO on page 70

PROP_SOFTWARESLOTS on page 71

PROP_UPD_INFPATH on page 48

TARGETDIR on page 48
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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ET_LANG_NAME Property

KSP_ENABLED Property

PROP_CLEAR_REG Property

READER_COUNT Property

Property Name ET_LANG_NAME

Description Determines the language in which the GUI is displayed

Value Chinese / Czech / English / French (Canada) / French / German / Hungarian / 
Italian / Japanese / Korean / Lithuanian / Polish / Portuguese / Romanian / Russian 
/ Spanish / Thai / Traditional Chinese / Vietnamese / Turkish

Note: Values that consist of two words (Traditional Chinese and French 
(Canada)), must be enclosed in double quotes.

Default English

NOTE: 
This feature can also be set using SafeNet Authentication Client Tools, Property Settings (ADM), or 
registry key.

Property Name KSP_ENABLED

Description Determines if KSP is installed

 Value 0 - KSP is not installed
1 - KSP is installed and used as the default cryptographic provider on Windows Vista 
or higher
2 - KSP is installed but the certificate’s provider details stored on the token are used. 
These are the details displayed when the certificate is selected in SAC Tools.

Default 2

Property Name PROP_CLEAR_REG

Description Determines if all registry settings are automatically cleared upon uninstall

 Value 1 (True) - Registry settings are cleared upon uninstall
0 (False)- Registry settings are not cleared upon uninstall

Default 0 (False)

NOTE: 
This feature can also be set using SafeNet Authentication Client Tools.
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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PROP_FAKEREADER Property

Property Name READER_COUNT

Description Determines the number of virtual readers for physical eToken devices only. This 
determines the number of eToken devices that can be connected concurrently.

Note: On Windows Vista 64-bit and on systems later than Windows 7 and 
Window 2008 R2, the total number of readers is limited to 10 from among: 
iKey readers, eToken readers, third-party readers, and reader emulations.

Value 0 - No virtual readers installed
1 - 16 - Number of virtual readers installed

Default 2

Property Name PROP_FAKEREADER

Description Determines if the emulation of a smartcard reader is installed, enabling SafeNet 
Virtual Tokens to be used with applications requiring a smartcard reader, such as 
smartcard logon and VPN.

Note: On Windows Vista 64-bit and on systems later than Windows 7 and 
Window 2008 R2, the total number of readers is limited to 10 from among: 
iKey readers, eToken readers, third-party readers, and reader emulations.

Value 1 (True) - Emulation of a smartcard reader is installed
0 (False)- Emulation of a smartcard reader is not installed
128 - No virtual readers

Default 1 (True)
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Document Number: 007-013560-005, Revision A

46



5 – Installation
READERS Property

PROP_LICENSE_FILE Property

PROP_REG_FILE Property

Property Name READERS

Description Determines the number of virtual readers for physical iKey devices only. This 
determines the number of iKey devices that can be connected concurrently.

Note: On Windows Vista 64-bit and on systems later than Windows 7 and 
Window 2008 R2, the total number of readers is limited to 10 from among: 
iKey readers, eToken readers, third-party readers, and reader emulations.

For example:
Following command line is enough if you want to change readers counters properties 
(and any additional properties):

C:\Windows\system32>msiexec /i "c:\temp\SafeNetAuthenticationClient-x32-
10.5.msi" READER_COUNT=1 READERS=1 /qb

Value 0 - No virtual readers are installed
1 - 16 - Number of virtual readers installed

Default 2

Property Name PROP_LICENSE_FILE

Description Defines the location of the SAC license file

Value The path to a file containing the SafeNet Authentication Client license

Note: The full path must be used.

Default none

Property Name PROP_REG_FILE

Description Defines the BSec settings .reg file, created manually, that is imported to the 
computer’s registry folder during the installation
The default registry folder is 
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC

Value The path to a saved registry file

Note: The full path must be used.

Default none
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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PROP_UPD_INFPATH Property

TARGETDIR Property

NOTE: 
While other command line installation properties set values only in 
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC, values set in the 
PROP_REG_FILE file are appended to the sub folders of the registry location.

Property Name PROP_UPD_INFPATH

Description Determines the update driver search path on install/uninstall

Value The update driver search path on install/uninstall

Default none

Property Name TARGETDIR

Description Determines which installation folder to use as the installation library for this and all 
future SafeNet Authentication application installations.
Use only if there are no other SafeNet Authentication or legacy eToken applications 
installed.

Value The path to the installation library

Default None - the application is installed in the default SafeNet Authentication installation 
folder

NOTE: 
Include the TARGETDIR property only if there are no other SafeNet Authentication applications or 
legacy eToken applications installed on the computer.
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Configuring Installation Features via the Command Line
To exclude specific features from the SafeNet Authentication Client installation, use the ADDDEFAULT parameter 
to install only those features required. The excluded features can be added afterwards to the installed application.

To install only specific features, use the following command format:

msiexec /i SafeNetAuthenticationClient-x32-10.5.msi ADDDEFAULT=F1,F2…Fn INSTALLLEVEL=n 
PROP_IKEYREADERCOUNT=n /qb

where

• SafeNetAuthenticationClient-x32-10.5 is the 32-bit SafeNet Authentication Client installation file. 
For 64-bit systems, use SafeNetAuthenticationClient-x64-10.5.msi.

• ADDDEFAULT indicates that only the following features are included in the installation, or added to the 
installed application.

• Fx is the name of each feature to be included.

• INSTALLLEVEL indicates the installation level, where n is:

• 3: standard installation (default)

NOTE: 
The number of iKey readers can be set from the command line only.
SafeNet Authentication Client 10.5 (GA) Administrator Guide
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SafeNet Authentication Client Command Line Feature Names

Feature Parent Name Command Line Feature 
Name

Description

DriverFeature eTokenDrivers Installs etoken drivers.

BsecDrivers Installs iKey drivers.

CoreFeature CAPI:

eTokenCAPI

IDPrimeCAPI

Installs the standard CAPI implementation for 
eToken, iKey and Gemalto IDPrime devices.

Installs the standard CAPI implementation for 
eToken and iKey devices.

Installs the standard CAPI implementation for 
Gemalto IDPrime devices.

eTokenPKCS11 Installs the standard PKCS#11 API implementation 
for eToken and iKey devices.

Note: This feature is mandatory.

UIDialogs Installs support for CAPI password dialogs.

Note: This feature is mandatory.

KSP:

CNG

IDPrimeKSP

Registers SafeNet Key Storage Provider.

Registers eToken and iKey devices for SafeNet 
Key Storage Provider (KSP).

Registers Gemalto IDPrime devices for SafeNet 
Key Storage Provider (KSP).

Applications SACTools Installs the SAC Tools application for managing 
devices.

Services SACService Installs eToken Service for the support of eToken 
and iKey devices.
Note: This feature is mandatory.

SACMonitor Installs SafeNet Authentication Client Monitor 
(Tray icon). 

Note: This feature is mandatory.

LegacyAPI eTokenSAPI Installs proprietary supplementary API.

TokenEngines eTokenDevices:

eTokenJava
eTokenCardOS

Support for JAVA and CardOS devices.

Support for Java devices.
Support for CardOS devices.

Note: the eToken Java feature is mandatory.

iKey Installs iKey token support.

eTokenVirtual Support for SafeNet Virtual Tokens.

IDPrime Support for IDPrime devices.
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Installing All Features - Example

To install SafeNet Authentication Client on a 32-bit system with all features, type the following command:

msiexec /i SafeNetAuthenticationClient-x32-10.5.msi

ADDDEFAULT=eTokenDrivers,BsecDrivers,eTokenCAPI,eTokenPKCS11,UIDialogs,KSP,SACTools,SACService,
SACMonitor,BsecCAPI,BsecPKCS11,eTokenSAPI,eTokenJava,eTokenCardOS,iKey,eTokenVirtual,IDPrime,IDPr
imeCAPI,IDPrimeKSP /qb

Installing All Features Except KSP Support - Example
To install SafeNet Authentication Client on a 32-bit system with all features except support for KSP, type the 
following command:

msiexec /i SafeNetAuthenticationClient-x32-10.5.msi KSP_Enabled=0 /qb 

Installing Specific Readers - Example
To install SafeNet Authentication Client on a 64-bit system with five eToken readers, three iKey readers, two 
SafeNet Virtual Token readers, and no smartcard reader emulation, type the following command:

msiexec /i SafeNetAuthenticationClient-x64-10.5.msi PROP_PCSCSLOTS=10 
PROP_ETOKENREADERCOUNT=5 PROP_IKEYREADERCOUNT=3 PROP_SOFTWARESLOTS=2 PROP_FAKEREADER=0 
/qb

Installing without eToken Drivers - Example
To install SafeNet Authentication Client without support for eToken devices on a 32-bit system, type the following 
command:

msiexec /i SafeNetAuthenticationClient-x32-10.5.msi ADDDEFAULT=

BsecDrivers,eTokenSAPI,eTokenPKCS11,IDPrime,IDPrimePKCS11,IDPrimeCAPI,eTokenCAPI,UIDi
alogs,SACMonitor,SACService,SACTools /qb

Any of the optional features in this example can be excluded.

IDGoCompatibleMode IDGoMinidriver Installs legacy IDGo 800 Minidriver.

IDGoPKCS11 Support for legacy IDGo 800 PKCS#11 
applications.

NOTE: 
To enable SafeNet token support without installing SafeNet Authentication Client Tools, use the 
SafeNet Authentication Client command line installation with eTokenDrivers and/or BsecDrivers 
only.

Feature Parent Name Command Line Feature 
Name

Description
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Document Number: 007-013560-005, Revision A

51



5 – Installation
Installing without SAC Tools - Example
To install SafeNet Authentication Client on a 32-bit system, with many standard features, but without the SafeNet 
Authentication Client Tools application, type the following command:

msiexec /i SafeNetAuthenticationClient-x32-10.5.msi ADDDEFAULT=
eTokenDrivers,BsecDrivers,eTokenSAPI,eTokenPKCS11,IDPrime,IDPrimePKCS11,IDPrimeCAPI,e
TokenCAPI,KSP,UIDialogs,SACMonitor,SACService /qb

To add the SafeNet Authentication Client Tools application to SafeNet Authentication Client on a 32-bit 
system after installation, type the following command:

msiexec /i SafeNetAuthenticationClient-x32-10.5.msi ADDDEFAULT=SACTools /qb

Removing Features via the Command Line

Installed features can be removed from the SafeNet Authentication Client installation. To remove features, use 
the following format:

msiexec /x SafeNetAuthenticationClient-x32-10.5.msi REMOVE=F1,F2…,Fn /qb

where

• SafeNetAuthenticationClient-x32-10.5.msi is the 32-bit SafeNet Authentication Client 
installation file. For 64-bit systems, use SafeNetAuthenticationClient-x64-10.5.msi

• REMOVE indicates that the following features are to be removed

• Fx is the name of each feature to be removed

Configuring Root Certificate Storage for Win Server 2008 R2
In most environments, no special configuration is required to store a root certificate on a token. In a Windows 
Server 2008 R2 environment, the Active Directory Certificate Service registry value, CertSvc, must be manually 
configured to enable a root certificate to be stored on a token. If it is not configured properly, the following 
message is displayed when an attempt is made to store a root certificate on a token: “Could not load or verify the 
current CA certificate. The system cannot find the file specified.”

To configure the registry to store a root certificate on a token in Windows Server 2008 R2:

1. In the Windows Registry Editor, create a registry value named RequiredPrivileges, in the Multi-String 
Value format, in the following location:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\CertSvc

For more information about creating and editing registry keys, see Setting Registry Keys Manuallyon page 66.

NOTE: 
Only optional features can be removed. Mandatory fields cannot be removed.

Example: To remove the SafeNet Authentication Client Tools application 
after it was installed with SafeNet Authentication Client on a 32-bit system, 
type the following command:

msiexec /x SafeNetAuthenticationClient-x32-10.5.msi 
REMOVE=SACTools /qb
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2. In the Registry Editor right column, right-click RequiredPrivileges, select Modify, and add the following lines 
to the value data:

SeTcbPrivilege

SeIncreaseQuotaPrivilege

SeAssignPrimaryTokenPrivilege

CertSvc is now configured to open the Token Logon window whenever access is required to the private key.
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Uninstall

After SafeNet Authentication Client 10.5 has been installed, it can be uninstalled. Local administrator rights are 
required to uninstall SafeNet Authentication Client. When SafeNet Authentication Client is uninstalled, user 
configuration and policy files may be deleted.

Uninstall Overview
If a device remains connected while SafeNet Authentication Client is being uninstalled, you will be prompted to 
remove the device before uninstalling the driver.

Use the Windows Control Panel Add and Remove Programs feature to uninstall the driver.

To remove SafeNet Authentication Client, use one of the following methods:

• Uninstalling via Add or Remove Programs on page 54

• Uninstalling via the Command Line on page 55

Uninstalling via Add or Remove Programs 

To uninstall via Add or Remove Programs:

1. From the Windows taskbar, select Start > Settings > Control Panel.

2. Double-click Add or Remove Programs.

3. Select SafeNet Authentication Client 10.5 and click Remove.

4. Follow the instructions to remove the application.

If the PROP_CLEAR_REG property was not enabled during installation, a Save settings window is 
displayed.

5. Click Yes to save the machine and user registry settings, or No to delete them.

The uninstall process proceeds.

NOTE: 
• If a DLL is in use by another application, a Files in Use message is displayed. Click Ignore to 

continue the uninstall, and when the uninstall completes, restart the computer.
• If the PROP_CLEAR_REG property was enabled when SafeNet Authentication Client was 

installed, all machine and user registry settings are automatically cleared during the uninstall.
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Uninstalling via the Command Line
If the PROP_CLEAR_REG property is not enabled, the registry settings are retained during uninstall via the 
command line.

To uninstall via the command line:

1. Log on as an administrator.

2. Close all applications.

3. From the Windows taskbar, select Start > Programs > Accessories > Command Prompt.

Right-click Command Prompt, and select Run as Administrator.

4. Type the appropriate command line utility:

msiexec /x SafeNetAuthenticationClient-x32-10.5.msi (for 32-bit installations)

msiexec /x SafeNetAuthenticationClient-x32-10.5.msi (for 64-bit installations)

To uninstall in silent mode, add /qn to the end of the command.

5. When the uninstall completes, restart the computer.
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SafeNet Authentication Client Settings

SafeNet Authentication Client settings are policy settings that are stored in a Windows Administrative Template 
(ADM or ADMX) file, and can be edited using Windows tools. When edited on the server, the settings can be 
propagated to client computers.

SafeNet Authentication Client Settings Overview
Administrative Template files are used to display registry-based SafeNet Authentication Client policy settings for 
editing by the administrator.

Sample Administrative Template files are provided by SafeNet in the SafeNet Authentication Client software 
package.

Sample Administrative Template files provided by SafeNet:

Use the Active Directory Group Policy Object Editor (GPO) to configure the Administrative Template ADM and 
ADMX files.

When configured on a client, SafeNet Authentication Client settings apply to the local computer only.

When configured on a server, SafeNet Authentication Client settings can be set to be propagated to the entire 
domain, or to apply to the domain controllers only.

The sample Administrative Template files provided by SafeNet are configured to write registry settings to:
HKEY_LOCAL_MACHINE\SOFTWARE\Policies\SafeNet\Authentication\SAC

The values in this folder have a higher priority than values in any other registry folder. See "Application Properties 
Hierarchy" on page 65 for an explanation of the registry folders.

To write settings to a different registry folder, modify the Administrative Template file.

Sample File Configuration

SAC_[Major_Minor].adm SafeNet Authentication Client settings

SAC_[Major_Minor].admx SafeNet Authentication Client settings

SAC_[Major_Minor].adml File of English strings

NOTE: •
• When setting the Microsoft GPO parameter ForceReadingAllCertificates to ‘Enabled’ or ‘Not 

Configured’, all smart card logon certificates are visible on the operating system log on screen. 
• When setting the Microsoft GPO parameter ForceReadingAllCertificates to ‘Disabled’, only 

the default smart card logon certificates is visible on the operating system log on screen. 
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Adding SafeNet Authentication Client Settings
Add the Administrative Templates snap-in to enable you to modify the SafeNet Authentication Client settings.

• To add the Administrative Templates to Windows Server 2008 SP1 or Windows Server 2008 R2 SP1, do 
one of the following:

• Add a standard ADM Administrative Template file. See "Adding an ADM file to Windows Server 2008 
/ R2" on page 57.

• Add an XML-based ADMX Administrative Template file. See "Adding an ADMX file to Windows Server 
2008 / R2" on page 59.

• To add the Administrative Templates to a client computer, see Adding an ADM file to a Client Computer 
on page 60.

Configuring SAC Password Prompt Settings

You can configure SAC logon settings to request a password prompt on every cryptographic operation 
performed.

To activate the password prompt request whenever a cryptographic API (CAPI) operation is required, ensure 
either one of the following parameters exist:

• Ensure the certificate you are using includes a Non Repudiation OID (generated via Entrust). See 
"General Settings" on page 68 for more details on the Non Repudiation OIDs setting.

• Ensure the certificate you are using includes an Identity OID. See "IdenTrust Settings" on page 113 for 
more details on the Identity OIDs setting.

• Open SAC tools>Advanced View>Token Settings>Advanced Tab, and set the RSA key secondary 
authentication parameter to Token authentication on application request.

• Logout Mode setting is True.

Adding an ADM file to Windows Server 2008 / R2

When configured on a server, SafeNet Authentication Client settings can be set to be propagated to the entire 
domain, or to apply to the domain controllers only.

To add SafeNet Authentication Client settings:

1. From the Windows taskbar, select Start > Run.

2. In the Run dialog box, enter gpmc.msc, and click OK.
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The Group Policy Management window opens.

3. Do one of the following:

• To propagate the settings to all clients in the domain, right-click Default Domain Policy under the 
domain node.

• To apply the settings to the local machine and any other domain controllers in this domain, right-click 
Default Domain Controllers Policy under the domain node.

4. From the dropdown menu, select Edit.

The Group Policy Management Editor opens.

5. Under Computer Configuration > Policies, right-click Administrative Templates: Policy definitions 
(ADMX files), and select Add/Remove Templates.

The Add/Remove Templates window opens.
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6. Click Add, and browse to the appropriate ADM file.

Sample files are included in the SafeNet Authentication Client software package provided by SafeNet.

7. Select the file, and click Open.

The selected template file is displayed in the Add/Remove Templates window.

8. Click Close.

In the Group Policy Management Editor window, the Settings node is added under Administrative 
Templates: Policy definitions (ADMX files).

Adding an ADMX file to Windows Server 2008 / R2

When using an ADMX file, you can decide in which language to display the settings. The sample ADMX folder 
provided by SafeNet includes English language adml files.

To add SafeNet Authentication Client settings:

1. Copy the file SAC_8_3.admx that is included in the SafeNet Authentication Client software package 
provided by SafeNet to the following location:
C:\Windows\PolicyDefinitions

2. Copy the appropriate adml language file (SAC_8_3.adml) to a language folder in the following location:
C:\Windows\PolicyDefinitions\

NOTE: 
The English language file provided by SafeNet should be written to:
C:\Windows\PolicyDefinitions\en-US
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Adding an ADM file to a Client Computer

You can add ADM files to Windows 7, 8, 8.1, and 10. When configured on a client, SafeNet Authentication Client 
settings apply to the local computer only.

To add SafeNet Authentication Client settings:

1. From the Windows taskbar, select Start > Run.

2. In the Run dialog box, enter gpedit.msc, and click OK.

The Local Group Policy Editor opens.

3. Under the Computer Configuration node, right-click Administrative Templates, and select Add/Remove 
Templates.

The Add/Remove Templates window opens.

4. Click Add, and browse to the appropriate ADM file.

Sample files are included in the SafeNet Authentication Client software package provided by SafeNet.

5. Select the file, and click Open.

The selected template file is displayed in the Add/Remove Templates window.

6. Click Close.

In the Local Group Policy Editor window, the Settings node is added under Administrative Templates > 
Classic Administrative Templates (ADM).
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Editing SafeNet Authentication Client Settings
Each SafeNet Authentication Client Settings folder contains settings that can be configured to have priority over 
the SafeNet Authentication Client application defaults.

When you edit the settings, values in the registry key are changed. For more information, see Configuration 
Properties on page 65.

• To edit the policy settings on Windows Server 2008 or Windows Server 2008 R2, see Editing Settings in 
Windows Server 2008 / R2 on page 61.

• To edit the policy settings on a client computer, see Editing Settings on a Client Computer on page 63.

Editing Settings in Windows Server 2008 / R2

To edit SafeNet Authentication Client settings:

1. From the Windows taskbar, select Start > Run.

2. In the Run dialog box, enter gpmc.msc, and click OK.

The Group Policy Management window opens.

3. Do one of the following:

• To propagate the settings to all clients in the domain, right-click Default Domain Policy under the 
domain node.

• To apply the settings to the local machine and any other domain controllers in this domain, right-click 
Default Domain Controllers Policy under the domain node.
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4. From the dropdown menu, select Edit.

The Group Policy Management Editor opens.

5. In the left pane, expand Computer Configuration > Policies > Administrative Templates: Policy 
definitions (ADMX files).

6. Select one of the SafeNet Authentication Client Settings nodes.

The settings are displayed in the right pane.

7. Select the settings folder to edit.

The settings are displayed in the right pane.

8. Double-click the setting to edit.

9. Select the Explain tab for an explanation of the setting and its values.

10. In the Setting tab, select one of the following:

• Not Configured

No change is made to the registry for this setting

• Enabled

The registry is changed to indicate that the policy applies to users or computers that are subject to this 
GPO.

• Disabled

The registry is changed to indicate that the policy does not apply to users or computers that are subject 
to this GPO.

11. If Enabled is selected, complete the values in the box.

12. Click Previous Setting or Next Setting to progress through the settings in the same folder, or click OK to 
return to the list of settings.

The registry is updated.
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Editing Settings on a Client Computer

To edit SafeNet Authentication Client settings:

1. From the Windows taskbar, select Start > Run.

2. In the Run dialog box, enter gpedit.msc, and click OK.

The Local Group Policy Editor opens.

3. In the left pane, navigate to Computer Configuration > Administrative Templates > Classic 
Administrative Templates.

4. Select one of the SafeNet Authentication Client Settings nodes.

The settings are displayed in the right pane.

5. Continue from Editing Settings in Windows Server 2008 / R2 - Step 8 above.
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Deploying SafeNet Authentication Client Settings
After editing the SafeNet Authentication Client settings on the server, update the registry settings on the server 
and on all client computers on which SafeNet Authentication Client is installed.

To apply SafeNet Authentication Client settings:

1. From the Windows taskbar, select Start > Run.

2. In the Run dialog box, enter gpupdate, and click OK.

The registry values on the server are updated to the SafeNet Authentication Client Settings values.

3. On each client computer’s Windows taskbar, select Start > Run.

4. In the Run dialog box, enter gpupdate, and click OK.

The registry values are copied from the server to the client computer.
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Configuration Properties

SafeNet Authentication Client properties are stored on the computer as registry key values which can be added 
and changed to determine SafeNet Authentication Client behavior. Depending on where a registry key value is 
written, it will apply globally, or be limited to a specific user or application.

Setting SafeNet Authentication Client Properties
Depending on the property, registry key values can be set using at least one of the following methods:

• Define the property during command line installation of SafeNet Authentication Client (but not during 
repair). See "Installing the MSI file via the Command Line" on page 42.
The property name, and not the registry value name, is needed when setting the value during command 
line installation.

• Set a value using the SafeNet Authentication Client Tools application.
See the SafeNet Authentication Client User’s Guide.
Neither the registry value name nor the property name is needed.

• Set a value using the Administrator Templates (ADM/ADMX) policy settings.
See Chapter 7: SafeNet Authentication Client Settings, on page 56.
The registry value name, and not the property name, is needed when setting the value.

• Manually edit the registry setting.
See Setting Registry Keys Manually on page 66.
The registry value name, and not the property name, is needed when setting the value.

Application Properties Hierarchy
Each property can be defined in up to four registry key folders. For each property, the setting found in the highest 
level of the hierarchy determines the application’s behavior.

If a property is set in a folder which requires administrator permissions, that setting overrides any other settings 
for that property.

Hierarchy List

SafeNet Authentication Client uses the following hierarchy to determine the application’s behavior:

1. HKEY_LOCAL_MACHINE\SOFTWARE\Policies\SafeNet\Authentication\SAC

NOTE: 
Values set using the SafeNet Authentication Client Tools application are saved on a per user basis 
in HKEY_CURRENT_USER, and not in HKEY_LOCAL_MACHINE.

NOTE: 
• All properties can be manually set and edited.
• It is recommended to set the policies using the Administrator Templates (ADM/ADMX) policy 

settings. This option allows spreading policies in a controlled manner and ensures that end 
users are not able to override any policies. For more information, refer to the section below: 
Application Properties Hierarchy.
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Requires administrator permissions.

2. HKEY_CURRENT_USER\SOFTWARE\Policies\SafeNet\Authentication\SAC

Requires administrator permissions.

3. HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC

Requires administrator permissions.

4. HKEY_CURRENT_USER\SOFTWARE\SafeNet\Authentication\SAC

Does not require administrator permissions.

5. SafeNet Authentication Client default value

Hierarchy Implications

The applications properties hierarchy has the following implications:

• When you use the sample Administrative Template (ADM/ADMX) files supplied by SafeNet to edit 
SafeNet Authentication Client Settings, the edited properties are written to: 
HKEY_LOCAL_MACHINE\SOFTWARE\Policies\SafeNet\Authentication\SAC.

These values override values set by any other method.

• When you set properties using SafeNet Authentication Client Tools, the edited properties are written to: 
HKEY_CURRENT_USER\SOFTWARE\SafeNet\Authentication\SAC.

These values override values set during command line installation. Since Tools settings apply “per user” only 
after the user is authenticated, the user must first log on to Windows before these settings take effect.

• When you set properties during command line installation, the properties (except for PROP_REG_FILE) 
are written to: HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC.

• When you set properties manually, write them to their appropriate registry keys in any of the registry 
folders listed in the Hierarchy List on page 65. Unless the properties must override other settings, we 
recommend writing them to: HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC.

Setting Registry Keys Manually

To set a registry key value:

1. From the Windows taskbar, select Start > Run.

2. In the Run dialog box, enter regedit, and click OK. 

The Registry Editor opens, displaying the registry folders tree in the left pane.

3. Expand the tree, and select the folder of the required registry key.

Unless the properties must override other settings, we recommend writing them to: 
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC.

4. If a property’s folder does not exist in the Registry Editor tree, create it.

The names and settings of the values in the registry key are displayed in the right pane.

The registry value name, and not the property name, is used when setting the value manually.

5. To rename or delete a value, or to modify its data, right-click its Name.

6. Registry settings that are not displayed in the right pane can be added.
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To add a value to the registry key, or to add a new registry key in the tree, right-click the white space in the 
right pane.

Defining a Per Process Property
You can set properties to be limited to specific applications. To do this, open the registry key in which the property 
belongs, create a registry folder within it, and assign the new folder the full name of the process. Then define the 
appropriate settings within the process’s folder.

In the following example, the Single Logon feature is defined for the Internet Explorer process only. It will not 
apply to any other process.

To define a per process property, such as Single Logon for IE only:

1. From the Windows taskbar, select Start > Run.

2. In the Run dialog box, enter regedit, and click OK.

The Registry Editor opens, displaying the registry folders tree in the left pane.

3. Expand the appropriate registry tree.
In this example, the tree is HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC\

4. Ensure that a folder exists in which the property belongs.
In this example, the property must be written to the General folder.
If the General folder does not exist, right-click SAC, select New > Key, and assign it the name General.

5. Right-click the folder in which the property belongs.
In this example, right-click the General folder.

6. If a new registry key is required, select New > Key, and assign it the name of the process.
In this example, IEXPLORE.EXE.

To define a per process property, such as Password Timeout for a certain CAPI process:

1. From the Windows taskbar, select Start > Run.

2. In the Run dialog box, enter regedit, and click OK.

The Registry Editor opens, displaying the registry folders tree in the left pane.

3. Expand the appropriate registry tree.
In this example, the tree is 
HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC\CAPI\[Process Name 
e.g. AcroRd32.exe]
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General Settings
The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\General registry 
key.

NOTE: 
The example below explains how to integrate between two registry processes. 

The Single Logon feature can be defined for both the Internet Explorer process as well as for the 
Adobe Password Timeout process. To perform this, define the following configurations:

[HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC\CAPI\AcroRd32.exe]
"PasswordTimeout"=dword:00000001
[HKEY_LOCAL_MACHINE\SOFTWARE\SafeNet\Authentication\SAC\General\IEXPLORE.EXE]
"Singlelogon"=dword:00000001

AcroRd32.exe can be replaced by any other CAPI process.

Description ADM File Setting Registry Value  Command Line

NoPinPad

Determines whether or not the 
PIN Pad reader is used as a 
regular smart card reader. SAC 
UI will require entering user 
credentials.

 Not supported Registry Value Name:
NoPinPad

Values:
0 - Disabled

1 - Enabled

Default: 0 (Disabled)

Cannot be set by
command line
installation.

FullSMMode

Enables/disables the full 
Security Messaging (SM) mode 
for IDPrime MD FIPS L2 
devices.

Note: SAC cache must be reset 
after changing the FullSMMode 
property.

This configuration is for applet 
4.3.5 L2 cards only.

 Not supported Registry Value Name:
FullSMMode

Values:
0 (False) - Disabled

1 (True) - FIPS L2 only

Default: 0 (Disabled)

Cannot be set by
command line
installation.
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Multi-Slot Support

Determines if SafeNet 
Authentication Client is 
backward
compatible with Gemalto 
PKCS#11 Common Criteria 
devices
(IDPrime MD 840, IDPrime MD 
3840 and eToken 5110 CC).

The Multi-Slot feature affects 
only SAC customized in 
compatible mode via 
IDPrimePKCS11.dll 
(i.e. The IDGo 800 PKCS#11 
option is selected in the 
Customization Tool. See 
Chapter 3: “Configuring IDGo 
800 PKCS#11 for Backward 
Compatibility” on page 20.

For more information on Multi-
Slots, see the PKCS#11 Digital
Signature PIN Authentication 
section of the SafeNet
Authentication Client User 
Guide.
Note: Linked Mode is not 
compatible with the Multi-Slot 
feature.

Value Name:
MultiSlotSupport

Values:

Selected - Activates this feature
Not Selected - Normal 
operation

Default: Not Selected

Cannot be set by 
command line 
installation.

Description (Cont.) ADM File Setting Registry Value (Cont.)  Command Line 
SafeNet Authentication Client 10.5 (GA) Administrator Guide
Document Number: 007-013560-005, Revision A

69



8 – Configuration Properties
Single Logon

Determines if the user’s Token 
Password is requested only 
once for applications using MS 
cryptography (CAPI, eToken 
Base Cryptographic Provider, 
SafeNet Smart Card Key 
Storage Provider).

Note: 

• Can be set in SafeNet 
Authentication Client Tools, 
but since Tools settings apply 
“per user” only after the user 
is authenticated, the user 
must first log on to Windows, 
and only the next Token 
Password entry will be 
saved.

• To force Single Logon to start 
from Windows Logon, define 
this setting in 
HKEY_LOCAL_MACHINE

• PKCS11 is also supported 
for SAC login windows only. 
This can be achieved only 
when the PKCS11 function 
C_Login is configured with 
PIN=Null.

• SingleLogon is not supported 
when using PinPad readers.

Setting name: Single 
Logon

Selected - Token 
Password is requested 
only once
Not Selected- Token 
Password is requested 
as needed
Default: Not selected

Values:
Single Logon Timeout 
>= 0 (0 = no timeout)

Default: 0

Registry Value Name:
SingleLogon

Values:
1 (True) - Token Password is 
requested only once
0 (False) - Token Password is 
requested as needed

Default: 0 (False)

Property name:
PROP_SINGLELOG
ON

Single Logon Timeout

Determines the timeout, in 
seconds, of a single logon.

Note: 

• Applies only when Single 
Logon is True.

• Applies to all connected 
tokens and affects all 
applications using these 
tokens.

Single Logon Timeout 
is set in the Single 
Logon setting. (See 
“Single Logon” entry 
above.)

Registry Value Name: 
SingleLogonTimeout

Value: >=0 (Seconds)

Default: 0 (no timeout)

Property name:
PROP_SINGLELOG
ONTO

Description (Cont.) ADM File Setting Registry Value (Cont.)  Command Line 
SafeNet Authentication Client 10.5 (GA) Administrator Guide
Document Number: 007-013560-005, Revision A

70



8 – Configuration Properties
Software Slots

Defines the number of virtual 
readers for SafeNet Virtual 
Tokens.

Note: Can be modified in 
‘Reader Settings’ in SafeNet 
Authentication Client Tools also.

On Windows Vista 64-bit and on 
systems later than Windows 7 
and Window 2008 R2, the total 
number of readers is limited to 
10 from among: iKey readers, 
eToken readers, third-party 
readers, and reader emulations.

Setting name: 
Software Slots

Values: >=0
(0 = SafeNet Virtual 
Token is disabled; only 
physical tokens are 
enabled)

Default: 2

Registry Value Name: 
SoftwareSlots

Values: >=0
(0 = SafeNet Virtual Token is 
disabled; only physical tokens 
are enabled)

Default: 2

Property name:
PROP_SOFTWARES
LOTS

PCSC Slots

Defines the total number of 
PC/SC slots for all USB tokens 
and smartcards.
Included in this total:
• the number of allocated 

readers for third-party 
providers

• the number of allocated iKey 
readers, which is defined 
during installation and 
cannot be changed

• the number of allocated 
readers for other SafeNet 
physical tokens, which can 
be modified in ‘Reader 
Settings’ in SafeNet 
Authentication Client Tools

Note: On Windows Vista 64-bit 
and on systems later than 
Windows 7 and Window 2008 
R2, the total number of readers, 
consisting of this value and any 
enabled reader emulations, is 
limited to 10.

Setting name: PCSC 
Slots

Values: >=0
(0 = Physical tokens 
are disabled; only 
SafeNet Virtual Tokens 
are enabled)

Default: 8

Registry Value Name: 
PcscSlots

Values: >=0
(0 = Physical tokens are 
disabled; only SafeNet Virtual 
Token is enabled)

Default: 8

Property name:
PROP_PCSCSLOTS

Description (Cont.) ADM File Setting Registry Value (Cont.)  Command Line 
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HID Slots

Defines the total number of HID 
slots for all HID USB tokens.

Setting name: HID 
Slots

Values:=0, =2, >=0

0 - 5200 token works 
in VSR mode.

2 = 5200 HID token 
works in HID mode (2 
slots).

Default: 2

Registry Value Name: HIDSlots

Values: =0, =2, >=0

Default: 2 slots

Property name:
PROP_HIDSLOTS

Legacy Manufacturer Name

Determines if 'Aladdin 
Knowledge Systems Ltd.' is 
written as the manufacturer 
name in token and token slot 
descriptions
Use for legacy compatibility only

Setting name: Legacy 
Manufacturer Name

Values:
Selected - The legacy 
manufacturer name is 
written
Not selected - The 
new manufacturer 
name is written

Default: Not selected

Registry Value Name: 
LegacyManufacturerName
Values:
1 - The legacy manufacturer 
name is written
0 - The new manufacturer name 
is written

Default: 0

Cannot be set by 
command line 
installation.

Enable Private Cache

Determines if SafeNet 
Authentication Client allows the 
token’s private data to be 
cached.
Applies only to tokens that were 
initialized with the private data 
cache setting.
The private data is cached in per 
process memory.

Note: Can be set in SafeNet 
Authentication Client Tools

Setting name: Enable 
Private Cache

Values:
Selected - Private 
data caching is 
enabled
Not selected - Private 
data caching is 
disabled

Default: Selected

Registry Value Name: 
EnablePrvCache

Values:
1 (True) - Private data caching is 
enabled
0 (False) - Private data caching 
is disabled

Default:1 (True)

Cannot be set by 
command line 
installation.

Tolerate Finalize

Determines if C_Finalize can be 
called by DllMain

Note: 

Define this property per process
Select this setting when using 
Novell Modular Authentication 
Service (NMAS) applications 
only

Setting name: 
Tolerate Finalize

Values:
Selected - C_Finalize 
can be called by 
DllMain
Not selected - 
C_Finalize cannot be 
called by DllMain

Default: Not selected

Registry Value Name: 
TolerantFinalize

Values:
1 (True) - C_Finalize can be 
called by DllMain
0 (False) - C_Finalize cannot be 
called by DllMain

Default: 0 (False)

Cannot be set by 
command line 
installation

Description (Cont.) ADM File Setting Registry Value (Cont.)  Command Line 
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Tolerate X509 Attributes

Determines if 
CKA_SERIAL_NUMBER, 
CKA_SUBJECT, and 
CKA_ISSUER attributes can 
differ from those in CKA_VALUE 
during certificate creation

Note: 

Enable TolerantX509Attributes 
when using certificates created 
in a non- DER encoded binary 
x.509 format.
In some versions of PKI Client, 
this setting was not selected by 
default.

Setting name: 
Tolerate X509 
Attributes

Values:
Selected - The 
attributes can differ
Not selected- Check 
that the values match

Default: Not selected

Registry Value Name: 
TolerantX509Attributes

Values:
1 (True) - The attributes can 
differ
0 (False) - Check that the values 
match

Default: 0 (False)

Cannot be set by 
command line 
installation

Tolerate Find Templates

Determines if PKCS#11 
tolerates a Find function with an 
invalid template, returning an 
empty list instead of an error.

Setting name: 
Tolerate Find 
Templates

Values:
Selected - A Find 
function with an invalid 
template is tolerated 
and returns an empty 
list
Not Selected - A Find 
function with an invalid 
template is not 
tolerated and returns 
an error

Default: Not selected

Registry Value Name: 
TolerantFindObjects

Values:
1 (True) - A Find function with 
an invalid template is tolerated 
and returns an empty list
0 (False) - A Find function with 
an invalid template is not 
tolerated and returns an error

Default: 0 (False)

Cannot be set by 
command line 
installation

Disconnect SafeNet Virtual 
Token on Logoff

Determines if SafeNet Virtual 
Tokens are disconnected when 
the user logs off.

Setting name: 
Disconnect SafeNet 
Virtual Token on Logoff

Values:
Selected - Disconnect 
SafeNet Virtual Token 
when logging off
Not selected - Do not 
disconnect SafeNet 
Virtual Token when 
logging off

Default: Not selected

Registry Value Name: 
EtvLogoffUnplug

Values:
1 (True) - Disconnect SafeNet 
Virtual Token when logging off
0 (False) - Do not disconnect 
SafeNet Virtual Token when 
logging off

Default: 0 (False)

Cannot be set by 
command line 
installation.
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Protect Symmetric Keys

Determines if symmetric keys 
are protected

Note: 

If selected, even non-sensitive 
symmetric keys cannot be 
extracted

Setting name: Protect 
Symmetric Keys

Values:
Selected - Symmetric 
keys cannot be 
extricated
Not selected - 
Symmetric keys can 
be extricated

Default: Not selected

Registry Value Name: 
SensitiveSecret

Values:
1 - Symmetric keys cannot be 
extracted
0 - Symmetric keys can be 
extracted

Default: 0

Cannot be set by 
command line 
installation.

Cache Marker Timeout

Determines if SAC Service 
periodically inspects the cache 
markers of connected tokens for 
an indication that token content 
has changed

Note: 

If tokens were initialized as 
"eToken PKI Client 3.65 
compatible" in SafeNet 
Authentication Client 8.0 and 
later, set this value to 0 to 
improve performance.

Setting name: Cache 
Marker Timeout

Values:
Selected - Connected 
tokens' cache markers 
are periodically 
inspected
Not selected - 
Connected tokens' 
cache markers are 
never inspected

Default: Selected

Registry Value Name: 
CacheMarkerTimeout

Values:
1 - Connected tokens' cache 
markers are periodically 
inspected
0 - Connected tokens' cache 
markers are never inspected

Default: 0

Cannot be set by 
command line 
installation.

Override Non-Repudiation 
OIDs

Overrides SAC's list of standard 
certificate OIDs that require a 
high level of security

Note: 

Users must log on to their tokens 
whenever signing with a 
certificate defined as non-
repudiation.

To avoid having to authenticate 
every time a cryptographic 
operation is required for 
certificates containing Entrust 
certificate OID details, remove 
the default registration key 
value.

Setting name: 
Override Non-
Repudiation OIDs

Value:
Empty

Default: No override

Registry Value Name: 
NonRepudiationOID

Value:
Empty

Default: No override

Cannot be set by 
command line 
installation.
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Ignore Silent Mode

Determines if the Token Logon 
window is displayed even when 
the application calls the 
CSP/KSP in silent mode.

This feature cannot be 
set in the GPO Editor 
or MMC

Registry Value Name: 
IgnoreSilentMode

Values:
1 (True) - Display the Token 
Logon window even in silent 
mode
0 (False) - Respect silent mode

Note: 

Set to True when the SafeNet 
RSA KSP must use SHA-2 to 
enroll a CA private key to a 
token

Default: 0 (False)

Cannot be set by 
command line 
installation.

ITI Certification Mode

Enables ITI Certification, which 
requires the following:

• Administrator and User 
Passwords must be changed 
at first logon.

• If Initialization is performed 
without changing the 
Administrator and User 
Passwords at first logon, the 
Administrator Password is 
required for the initialization 
process.

Note: When the ITI Certification 
Mode property is enabled, the 
Enable Administrator Password 
Quality Check property will be 
disabled.

None Registry Value Name: 
MustChangeAdmin

Values:

0- None
1 - ITI certification mode
2 - Special administrator PIN 
policy only

Default: 0

Cannot be set by 
command line 
installation.

TempDir

Determines the path to a folder
containing the SafeNet
Authentication Client internal 
services folder (eToken.cache, 
eToken.HID, eToken.Log, 
eToken.Lock).

Not supported Registry Value Name: TempDir

Value:
Enter a folder name e.g. 
C:\windows\temp

Default: 
Windows: C:\windows\temp
Note: This property is not 
supported on Linux and Mac

Description (Cont.) ADM File Setting Registry Value (Cont.)  Command Line 
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Token-Domain Password Settings
The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\SyncPin registry 
key.

License Settings
The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\License registry 
key.
.

Description ADM File Setting Registry Value  Command Line

Synchronize with Domain 
Password

Determines if 
synchronization is enabled 
between the eToken 
password and the domain 
password.

Note: If the “Smart card is 
required for interactive 
logon" flag is enabled in AD, 
it blocks the option to change 
the domain password. So 
changing the token's 
password via SAC will also 
fail.

Setting name: Synchronize 
with Domain Password

Values:
Name of the domain (written 
without a suffix) whose 
password is synchronized with 
the Token Password

None - Password 
synchronization is not enabled

Default: None

Registry Value Name: 
Domain

Values:
Name of the domain (written 
without a suffix) whose 
password is synchronized 
with the Token Password

None - Password 
synchronization is not 
enabled

Default: None

Cannot be set by 
command line 
installation.

Description ADM File Setting Registry Value  Command Line

SAC License String

Defines the license string 
issued by SafeNet for 
product registration

Setting name: SAC License 
String

Values:
License string provided by 
SafeNet

Default: None

Registry Value Name: 
License

Values:
License string provided by 
SafeNet

Default: None

Name of related 
property:
PROP_LICENSE_FI
LE
contains the path to 
the license string, but 
not the string itself.
See 
"PROP_LICENSE_F
ILE" on page 47.
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Initialization Settings
The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\INIT registry 
key.

NOTE: 
All setting in this section are not relevant to IDPrime MD cards, except for the LinkMode setting.

Description ADM File Setting Registry Value  Command 
Line

Maximum Token 
Password Retries

Defines the default 
number of consecutive 
failed logon attempts that 
lock the token.

Setting Name:
Maximum Token Password Retries

Values:
1-15

Default: 15

Registry Value Name: 
UserMaxRetry

Values:
1-15

Default: 15

Cannot be set 
by command 
line installation.

Maximum 
Administrator 
Password Retries

Defines the default 
number of consecutive 
failed administrator logon 
attempts that lock the 
token.

Setting name: Maximum 
Administrator Password Retries

Values:
1-15

Default: 15

Registry Value Name: 
AdminMaxRetry

Values:
1-15

Default: 15

Cannot be set 
by command 
line installation.

Legacy Format Version

Defines the default token 
format.

Setting Name:
Legacy Format Version

Values:
0 - Tokens are formatted as 
backwardly compatible to eToken PKI 
Client 3.65 (CardOS tokens only)

4 - Tokens are not formatted as 
backwardly compatible, and password 
quality settings can be saved on the 
token (CardOS tokens only)

5 - Format includes new RSA 
behavior that is not controlled by key 
size; each key is created in a separate 
directory (CardOS 4.20B FIPS or Java 
Card-based tokens only)

Default:
4, for CardOS tokens
5, for 4.20B FIPS and Java Card -
based tokens

Registry Value Name: 
Legacy-Format-Version

Values:
0 - Tokens are formatted as 
backwardly compatible to 
eToken PKI Client 3.65 
(CardOS tokens only)

4 - Tokens are not formatted as 
backwardly compatible, and 
password quality settings can 
be saved on the token 
(CardOS tokens only)

5 - Format includes new RSA 
behavior that is not controlled 
by key size; each key is 
created in a separate directory 
(CardOS 4.20B FIPS or Java 
Card-based tokens only)

Default:
4, for CardOS tokens
5, for 4.20B FIPS and Java 
Card -based tokens

Cannot be set 
by command 
line installation
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RSA-2048

Determines if the token 
support 2048-bit RSA 
keys by default.

Note: Can be set in 
SafeNet Authentication 
Client Tools.

Setting Name: RSA-2048

Values:
Selected - 2048-bit RSA keys are 
supported
Not selected - 2048-bit RSA keys are 
not supported

Default: Not selected

Registry Value Name: RSA-
2048

Values:
1(True) - 2048-bit RSA keys 
are supported
0 (False) - 2048-bit RSA keys 
are not supported

Default: 0 (False)

Cannot be set 
by command 
line installation

OTP Support

Determines if the token 
supports OTP generation 
by default.
This setting enables 
HMAC-SHA1 support, 
required by OTP tokens.

Note: Can be set in 
SafeNet Authentication 
Client Tools.

Setting Name: OTP Support

Values:
Selected - OTP generation is 
supported
Not selected - OTP generation is not 
supported

Default: Selected, for OTP tokens. 
Not selected, for other tokens

Registry Value Name: HMAC-
SHA1

Values:
1 (True) - OTP generation is 
supported
0 (False) - OTP generation is 
not supported

Default: 1 (True), for OTP 
tokens. 0 (False), for other 
tokens

Cannot be set 
by command 
line installation

RSA Area Size

For CardOS-based 
tokens, defines the 
default size, in bytes, of 
the area to reserve for 
RSA keys.

• The size of the area 
allocated on the token 
is determined during 
token initialization, and 
cannot be modified 
without initializing the 
token.

• RSA-Area-Size is not 
relevant when Legacy-
Format-Version is set 
to 5.

Note: Can be set in 
SafeNet Authentication 
Client Tools.

Setting Name: RSA Area Size

Values:
>=0
(0 =RSA keys cannot be created on a 
token)

Default: depends on the token size:

• For 16 K tokens, enough bytes for 
three 1024-bit keys

• For 32 K tokens, enough bytes for 
five 1024-bit keys

• For larger tokens, enough bytes for 
seven 1024-bit keys

Registry Value Name: RSA-
Area-Size

Default: depends on the token 
size:

• For 16 K tokens, enough 
bytes for three 1024-bit 
keys

• For 32 K tokens, enough 
bytes for five 1024-bit keys

• For larger tokens, enough 
bytes for seven 1024-bit 
keys

Cannot be set 
by command 
line installation.

Default Token Name

Defines the default Token 
Name written to tokens 
during initialization.

Setting Name: Default Token Name

Value: String

Default: My Token

Registry Value Name:
DefaultLabel

Value: String

Default: My Token

Cannot be set 
by command 
line installation.

Description ADM File Setting (Cont.) Registry Value  (Cont.)  Command 
Line (Cont.)
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API: Keep Token 
Settings

When initializing the 
token using the SDK, 
determines if the token is 
automatically re-
initialized with its current 
settings.

Note: If selected, this 
setting overrides all other 
initialization settings.

Setting Name:
API: Keep Token Settings

Values:
Selected - Use current token settings

Not selected - Override current token 
settings

Default: Not selected

Registry Value Name:
KeepTokenInit

Values:
1 (True) - Use current token 
settings
0 (False) - Override current 
token settings 

Default: 0 (False)

Cannot be set 
by command 
line installation.

Automatic Certification

When initializing the 
token using the SDK. If 
the token has FIPS or 
Common Criteria 
certification, the token is 
automatically initialized 
with the original 
certification.

Note: On an eToken 5110 
FIPS device, the token is 
initialized in FIPS mode 
even if a third-party appli-
cation enforces non FIPS 
mode.

Setting Name:
Automatic Certification

Values:
Selected - initialize the token with the 
original certification

Not selected - initialize the token 
without the certification 

Default: initialize the token without 
the certification.

Registry Value Name:
Certification

Values:
1(True) - initialize the token 
with the original certification.

0 (False) - initialize the token 
without the certification

Default: 1 (True)

Note: Previous to SAC 8.2, the 
default setting was 0 (False). 
As CardOS 4.2 does not 
support both FIPS and RSA-
2048, failure to take this into 
account this may lead to token 
initialization failure when using 
PKCS#11. To prevent this, 
ensure that the default is set to 
False, or else ensure that the 
application provides both the 
required FIPS and RSA-2048 
settings.

Cannot be set 
by command 
line installation.
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API: Private Data 
Caching

If using an independent 
API for initialization, and if 
'Enable Private Cache' is 
selected, determines the 
token’s private data 
cache default behavior.

Setting Name:
API: Private Data Caching

Values:
0 - Always (fastest); private data is 
cached when used by an application 
while the user is logged on to the 
token, and erased when the token is 
disconnected.

1 - While user is logged on; private 
data is cached when used by an 
application while the user is logged on 
to the token, and erased when the 
user logs off or the token is 
disconnected.

2 - Never; private data is not cached.

Default: 0 (Always)

Registry Value Name:
PrvCachingMode

Values:
0 - Always
1 - While user is logged on
2 - Never

Default: 0 (Always)

Cannot be set 
by command 
line installation.

Enable Private Data 
Caching Modification

Determines if the token’s 
Private Data Caching 
mode can be modified 
after initialization.

Setting Name:
Enable Private Data Caching 
Modification

Values:
Selected -Can be modified
Not selected -Cannot be modified

Default: Not selected

Registry Value Name:
PrvCachingModify

Values:
1 (True) - Can be modified
0 (False) - Cannot be modified

Default: 0 (False)

Cannot be set 
by command 
line installation.

Private Data Caching 
Mode

If ‘Enable Private Data 
Caching Modification' is 
selected, determines who 
has rights to modify the 
token’s Private Data 
Caching mode.

Setting Name:
Private Data Caching Mode

Values:

Admin -Only the administrator has 
rights
User -Only the user has rights

Default: Admin

Registry Value Name:
PrvCachingOwner

Values:
0 - Admin
1 - User

Default: 0 (Admin)

Cannot be set 
by command 
line installation.
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API: RSA Secondary 
Authentication Mode

If using an independent 
API for initialization, 
determines the default 
behavior for protecting 
RSA private keys on the 
token.

Setting Name:
API: RSA Secondary Authentication 
Mode

Values:

Never -New RSA private keys are not 
protected with an additional 
password.

Prompt on application request -If 
the key generation application 
requires key passwords to be created 
for strong private key protection, new 
RSA private keys must be protected 
with an additional password.

If the key generation application does 
not require strong private key 
protection, new RSA private keys are 
not protected with an additional 
password.

Registry Value Name:
2ndAuthMode

Values:
0 - Never
1 - Prompt on application 
request
2 - Always prompt user
3- Always
4 - Token authentication on 
application request

Default: 0 -(Never)

Cannot be set 
by command 
line installation.

Always prompt user - A prompt 
appears asking if a new RSA private 
key is to be protected with an 
additional password.

Always - New RSA private keys must 
be protected with an additional 
password.

Token authentication on application 
request - If the key generation 
application requires key passwords to 
be created for strong private key 
protection, new RSA private keys are 
protected with the Token Password.

Default: Never

Enable RSA Secondary 
Authentication Modified

Determines if the token’s 
RSA secondary 
authentication can be 
modified after 
initialization.

Setting Name:
Enable RSA Secondary 
Authentication Modified

Values:

Selected -Can be modified

Not selected -Cannot be modified

Default: Not selected

Registry Value Name:
2ndAuthModify

Values:
1 (True) - Can modify
0 (False) - Cannot modify 

Default: 0 (False)

Cannot be set 
by command 
line installation.
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SafeNet Authentication Client Tools UI Initialization Settings
The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\AccessControl 
registry key.

The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\InitApp registry 
key.

Use the same token and 
administrator 
passwords for digital 
signature operations.

Note: Linked Mode is not 
compatible with the Multi-
Slots feature.

Setting Name:
IDPrime Common Criteria Linked 
Mode

Values:

Selected -PUK is derived from the 
Administrator password and Digital 
Signature PIN is derived from the 
Token password

Not selected -Common Criteria Pin's 
are not managed

Default: Not selected

Registry Value Name:
LinkMode

Values:
1 (True) - Linked
0 (False) - Unlinked 

Default: 0 (False)

Cannot be set 
by command 
line installation.

Description ADM File Setting Registry Value  Command Line

Enable Advanced View 
Button

Determines if the 
Advanced View icon is 
enabled in SAC Tools

Setting Name: Enable 
Advanced View Button

 Values:
Selected - Enabled
Not selected -Disabled

Default: Selected

Registry Value Name: 
AdvancedView

Values:
1 - Selected
0 - Not selected

Default: 1

PROP_ADVANCED
_VIEW

Description ADM File Setting Registry Value  Command Line

Default Token Password

Defines the default Token 
Password

Setting Name: Default Token 
Password

Value: String

Default: 1234567890

Registry Value Name: 
DefaultUserPassword

Values: String

Default: 1234567890

Cannot be set by 
command line 
installation.
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Enable Change Password 
on First Logon

Determines if the “Token 
Password must be changed 
on first logon” option can be 
changed by the user in the 
Token Initialization window.

Note: 

This option is selected by 
default. If the option is de-
selected, it can be selected 
again only by setting the 
registry key.

Setting Name: Enable 
Change Password on First 
Logon

 Values:
Selected - Enabled
Not selected -Disabled

Default: Selected

Registry Value Name: 
MustChangePasswordEnable
d

Values:
1 - Selected
0 - Not selected

Default: 1

Cannot be set by 
command line 
installation.

Change Password on First 
Logon

Determines if the Token 
Password must be changed 
on first logon option is 
selected by default in the 
Token Initialization window.

Note: 

This option is not supported 
by iKey.

Setting Name: Change 
Password on First Logon

Values:
Selected
Not selected

Default: Selected

Registry Value Name: 
MustChangePassword

Value:
1 - Selected
0 - Not selected

Default: 1

Cannot be set by 
command line 
installation.

Private Data Caching

If Enable Private Cache is 
selected, determines the 
token’s private data cache 
default behavior.

Note: Can be set in SafeNet 
Authentication Client Tools. 
This option is not supported 
by IDPrime MD cards.

Setting Name: Private Data 
Caching

Values:
Always - (fastest) private data 
is cached when used by an 
application while the user is 
logged on to the token, and 
erased only when the token is 
disconnected
While user is logged on - 
private data is cached when 
used by an application while 
the user is logged on to the 
token, and erased when the 
user logs off or the token is 
disconnected
Never - private data is not 
cached

Default: Always

Registry Value Name: 
PrivateDataCaching

Values:
0 - (fastest) private data is 
cached when used by an 
application while the user is 
logged on to the token, and 
erased only when the token is 
disconnected
1 - private data is cached 
when used by an application 
while the user is logged on to 
the token, and erased when 
the user logs off or the token 
is disconnected
2 - private data is not cached

Default: 0

Cannot be set by 
command line 
installation.
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RSA Secondary 
Authentication Mode

Defines the default behavior 
for protecting RSA private 
keys on the token

Note: Can be set in SafeNet 
Authentication Client Tools. 
This option is not supported 
by IDPrime MD cards.

Setting Name: RSA 
Secondary Authentication 
Mode

Values:
Never - New RSA private keys 
are not protected with an 
additional password.
Prompt user on application 
request - If the key generation 
application requires key 
passwords to be created for 
strong private key protection, 
new RSA private keys must be 
protected with an additional 
password. If the key 
generation application does 
not require strong private key 
protection, new RSA private 
keys are not protected with an 
additional password.
Always prompt user - A 
prompt appears asking if a 
new RSA private key is to be 
protected with an additional 
password.
Always - New RSA private 
keys must be protected with 
an additional password.

Registry Value Name: 
RSASecondaryAuthentication
Mode
Values:
0 - Never
1 - Prompt user on application 
request
2 - Always prompt user
3 - Always
4 - Token authentication on 
application request

Default: 0

Cannot be set by 
command line 
installation

RSA Secondary 
Authentication Mode 
(continued).

Note: This option is not 
supported by IDPrime MD 
cards.

Token authentication on 
application request - If the 
key generation application 
requires key passwords to be 
created for strong private key 
protection, new RSA private 
keys are protected with the 
Token Password. If the key 
generation application does 
not require strong private key 
protection, new RSA private 
keys are not protected with 
any password.

Default: Never

Reuse Current Token 
Name

Determines if the token’s 
current Token Name is 
displayed as the default 
Token Name when the token 
is re initialized.

Setting Name: Reuse Current 
Token Name

Values:
Selected -The current Token 
Name is displayed
Not selected -The current 
Token Name is ignored

Default: Not Selected

Registry Value Name: 
ReadLabelFromToken

Values:
1 -The current Token Name is 
displayed
0 -The current Token Name is 
ignored

Default: 1

Cannot be set by 
command line 
installation.
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Maximum number of 1024-
bit RSA keys

Defines the amount of space 
to reserve on the token for 
Common Criteria certificates 
that use 1024 -bit RSA keys.

Note: This option is not 
supported by IDPrime MD 
cards.

Setting Name: Maximum 
number of 1024-bit RSA keys
Values:
0-16 certificates
Default: 0

Registry Value Name: 
NumOfCertificatesWith1024K
eys_help

Values:
0-16 certificates

Default: 0

Cannot be set by 
command line 
installation.

Maximum number of 2048-
bit RSA keys

Defines the amount of space 
to reserve 
on the token for Common 
Criteria 
certificates that use 2048-bit 
RSA keys.

Note: This option is not 
supported by IDPrime MD 
cards.

Setting Name: Maximum 
number of 2048-bit RSA keys

Values:
1-16 certificates

(For example, 1 = One 2048 -
bit RSA key certificate 
can be written)

Default: 4

Registry Value Name: 
NumOfCertificatesWith2048K
eys_help

Values:
1-16 certificates

Default: 4

Cannot be set by 
command line 
installation.

Enable IDPrime CC Cards 
Linked Mode Change

Allows suppressing linked 
and unlinked mode options 
at the time of initialization. 
This prevents end-users 
from initializing the card 
incorrectly.

Setting Name: Enable 
IDPrime CC Cards Linked 
Mode Change

Values:
0 (False) - cannot toggle 
between CC linked and 
unlinked mode

1 (True) - can toggle between 
CC linked and unlinked mode

Default: 1

Registry Value Name: 
EnableCCModeChange

Values:
0 (False) - cannot toggle 
between CC linked and 
unlinked mode

1 (True) - can toggle between 
CC linked and unlinked mode

Default: 1

Cannot be set by 
command line 
installation.

Description (Cont.) ADM File Setting (Cont.) Registry Value  (Cont.)  Command Line 
SafeNet Authentication Client 10.5 (GA) Administrator Guide
Document Number: 007-013560-005, Revision A

85



8 – Configuration Properties
SafeNet Authentication Client Tools UI Settings
The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\UI registry key.
 

Description ADM File Setting Registry Value  Command Line

Use Default Password

Determines if the Change 
Password on First Logon 
process assumes the current 
Token Password is the 
default (defined in the 
Default Token Password), 
and does not prompt the 
user to supply it.

Setting Name: Use Default 
Password

Values:
Selected - The default Token 
Password is automatically 
entered in the password field

Not selected -The default 
Token Password is not 
automatically entered in the 
password field

Default: Not selected

Registry Value Name: 
UseDefaultPassword

Values:
1 (True) - The default Token 
Password is automatically 
entered in the password field

0 (False) -The default Token 
Password is not automatically 
entered in the password field

Default: o (False)

Cannot be set by 
command line 
installation.

Password Term

Defines the term used for the 
token's user password.

Note: If a language other 
than English is used, ensure 
that the Password Terms are 
translated.

Setting Name: Password 
Term

Values:
Password
PIN
Passcode
Passphrase

Default: Password

Registry Value Name: 
PasswordTerm

Values (String):
Password
PIN
Passcode
Passphrase

Default: Password

Cannot be set by 
command line 
installation.

Decimal Serial Number

Determines if the Token 
Information window displays 
the token serial number in 
hexadecimal or in decimal 
format.

Setting Name: Decimal Serial 
Number

Values:
Selected -Displays the serial 
number in decimal format

Not selected -Displays the 
serial number in hexadecimal 
format

Default: Not selected

Registry Value Name: 
ShowDecimalSerial

Values:
1 (True) -Displays the serial 
number in decimal format

0 (False) -Displays the serial 
number in hexadecimal 
format

Default: 0

Cannot be set by 
command line 
installation.

Enable Tray Icon

Determines if the application 
tray icon is displayed when 
SafeNet Authentication 
Client is started.

Setting Name: Enable Tray 
Icon

Values:
Never show
Always show

Default: Always show

Registry Value Name: 
ShowInTray

Values:
0 - Never Show
1 - Always Show

Default: Always show

Cannot be set by 
command line 
installation.
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Enable Connection 
Notification

Determines if a notification 
balloon is displayed when a 
token is connected or 
disconnected.

Setting Name: Enable 
Connection Notification

Values:
Selected - Displayed
Not selected- Not displayed

Default: Not selected

Registry Value Name: 
ShowBalloonEvents

Values:

0 - Not Displayed
1 - Displayed

Default: 0

Cannot be set by 
command line 
installation.

iKey LED On

Determines when the 
connected iKey LED is on.

Note: 

When working with 
applications related to Citrix, 
set this value to 0.

Setting Name: iKey LED On

Values:
Selected - The iKey LED is 
always on when SAC Monitor 
is running
Not selected -The iKey LED 
is on when the token has open 
connections only

Default: Selected

Registry Value Name: 
IKeyLEDOn

Values:
1 - The iKey LED is always on 
when SAC Monitor is running
0 -The iKey LED is on when 
the token has open 
connections only

Default:1

Cannot be set by 
command line 
installation.

Enable Logging Control

Determines if the Enable 
Logging /Disable Logging 
button is enabled in the 
Client Settings Advanced tab

Setting Name: Enable 
Logging Control

Values:
Selected -Enabled
Not selected -Disabled

Default: Selected

Registry Value Name: 
AllowLogsControl

Values:
1 -Enabled
0 -Disabled

Default: 1

Cannot be set by 
command line 
installation.

Home URL

Overwrites the SafeNet 
home URL in SafeNet 
Authentication Client Tools

Setting Name: Home URL

Values:
Valid URL

Default: SafeNet’s home URL

Registry Value Name: 
HomeUrl

Values (String):
Valid URL

Default: SafeNet’s home URL

Cannot be set by 
command line 
installation.

eToken Anywhere

Determines if eToken 
Anywhere features are 
supported

Setting Name: eToken 
Anywhere

Values:
Selected -Supported
Not selected -Not supported

Default: Selected

Registry Value Name: 
AnywhereExtendedMode

Values:
1 -Supported
0 -Not supported

Default: 1

Cannot be set by 
command line 
installation.
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Enable Certificate 
Expiration Warning

Determines if a warning 
message is displayed when 
certificates on the token are 
about to expire.

Setting Name: Enable 
Certificate Expiration Warning

Values:
Selected - A message is 
displayed

Not selected - A message is 
not displayed

Default: Not Selected

Registry Value Name: 
CertificateExpiryAlert

Values:
1 (True) - Notify the user
0 (False) - Do not notify the 
user

Default: 1 (True)

Cannot be set by 
command line 
installation.

Ignore Archived 
Certificates

Determines if archived 
certificates are ignored, and 
no warning message is 
displayed for certificates that 
are about to expire.

Setting Name: Ignore 
Archived Certificates

Values:
Selected -Archived 
certificates are ignored

Not selected- A warning 
message is displayed if the 
token contains expired 
archived certificates.

Default: Selected

Registry Value Name: 
IgnoreArchivedCertificates

Values:
1 - Archived certificates are 
ignored

0 - A warning message is 
displayed if the token contains 
archived certificates.

Default: 1

Cannot be set by 
command line 
installation.

Ignore Expired Certificates

Determines if expired 
certificates are ignored, and 
no warning message is 
displayed for expired 
certificates.

Setting Name: Ignore Expired 
Certificates

Values:
Selected -Expired certificates 
are ignored
Not selected- A warning 
message is displayed if the 
token contains expired 
certificates

Default: Not selected

Registry Value Name: 
IgnoreExpiredCertificates

Values:
1 - Expired certificates are 
ignored
0 - A warning message is 
displayed if the token contains 
expired certificates

Default: 0

Cannot be set by 
command line 
installation.

Certificate Expiration 
Verification Frequency

Defines the minimum 
interval, in days, between 
certificate expiration date 
verifications.

Setting Name: Certificate 
Expiration Verification 
Frequency

Values:
> 0

Default: 
14 days

Registry Value Name: 
UpdateAlertMinInterval

Values:
> 0

Default: 
14 days

Cannot be set by 
command line 
installation.

Certificate Expiration 
Warning Period

Defines the number of days 
before a certificate's 
expiration date during which 
a warning message is 
displayed.

Setting Name: Certificate 
Expiration Warning Period

Values:
> =0
(0 = No warning)

Default: 30 days

Registry Value Name: 
ExpiryAlertPeriodStart

Values:
> =0
(0 = No warning)

Default: 30 days

Cannot be set by 
command line 
installation.
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Warning Message Title

Defines the title to display in 
certificate expiration warning 
messages

Setting Name: Warning 
Message Title

Values:
String

Default: SafeNet 
Authentication Client

Registry Value Name: 
AlertTitle

Values:
String

Default: SafeNet 
Authentication Client

Cannot be set by 
command line 
installation.

Certificate Will Expire 
Warning Message

Defines the warning 
message to display in a 
balloon during a certificate’s 
“Certificate Expiration 
Warning Period.”

Setting Name: Certificate Will 
Expire Warning Message

Values:
The message can include the 
following keywords
$EXPIRY_DATE - the 
certificate expiration date

$EXPIRE_IN_DAYS - the 
number of days until expiration

Default: A certificate on your 
token expires in 
$EXPIRE_IN_DAYS days.

Registry Value Name: 
FutureAlertMessage

Values:
String

Default: A certificate on your 
token expires in 
$EXPIRE_IN_DAYS days.

Cannot be set by 
command line 
installation.

Certificate Expired 
Warning Message

Defines the warning 
message to display in a 
balloon if a certificate's 
expiration date has passed.

Setting Name: Certificate 
Expired Warning Message

Values:
String

Default: Update your token 
now.

Registry Value Name: 
PastAlertMessage

Values:
String 

Default: Update your token 
now.

Cannot be set by 
command line 
installation.

Warning Message Click 
Action

Defines what happens when 
the user clicks the message 
balloon.

Setting Name: Warning 
Message Click Action 

Values:

• No action

• Show detailed message

• Open website

Default: No action

Registry Value Name: 
AlertMessageClickAction

Values:
0 - No action
1 - Show detailed message
2 - Open website

Default: 0

Cannot be set by 
command line 
installation.

Detailed Message

If “Show detailed message” 
is selected in “Warning 
Message Click Action” 
setting, defines the detailed 
message to display.

Setting Name: Detailed 
Message

Values:
String

No default

Registry Value Name: 
ActionDetailedMessage

Values:
String

No default

Cannot be set by 
command line 
installation.
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Website URL

 If “Open website” is selected 
in the “Warning Message 
Click Action” setting, defines 
the URL to display

Setting Name: Website URL

Values:
Website address

No default 

Registry Value Name: 
ActionWebSiteURL

Values (string):
Website address

No default 

Cannot be set by 
command line 
installation.

Enable Password 
Expiration Notification

Determines if a pop-up 
message is displayed in the 
system when the Token 
Password is about to expire.

Setting Name: Enable 
Password Expiration 
Notification

Values:
Selected - A message is 
displayed
Not selected - A message is 
not displayed

Default: Selected

Registry Value Name: 
NotifyPasswordExpiration

Values:
1 (True)- A message is 
displayed
0 (False) - A message is not 
displayed

Default: 1 (True)

Cannot be set by 
command line 
installation.

Display Virtual Keyboard

Determines if SafeNet’s 
keystroke-secure Virtual 
Keyboard replaces standard 
keyboard entry of password 
fields in the following 
windows:

• Token Logon

• Change Password

Note: 
The virtual keyboard 
supports English characters 
only.

Setting Name: Display Virtual 
Keyboard

Values:
Selected - Enabled
Not selected -Disabled

Default: Disabled

Registry Value Name: 
VirtualKeyboardOn

Values:
1 (True)- Virtual keyboard on
0 (False) - Virtual keyboard 
off

Default: 0 (False)

Cannot be set by 
command line 
installation.

Password Policy 
Instructions

If not empty, defines a string 
that replaces the default 
password policy description 
displayed in the Unlock and 
Change Password windows.

Setting Name: Modify 
Password Policy Description

Values:
If key does not exist, the 
default value is used:
“A secure 
%REPLACE_PASSWORD_T
ERM% has at least 8 
characters, and contains 
upper-case letters, lower-case 
letters, numerals, and special 
characters (such as !, $, #, 
%).”

If key exists, the value in the 
key is displayed.

Registry Value Name: 
PasswordPolicyInstructions

Values: String

Cannot be set by 
command line 
installation.
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Define Initialization Mode

Select this option if you want 
the 'Initialization Options' 
window (first window 
displayed when initializing a 
device) to be ignored.

Setting Name: Define 
Initialization Mode

Values:
0 - Display the ‘Initialization 
Options’ window
1 - The ‘Preserve the token 
settings and policies’ option in 
the Initialization options 
window will be selected. (Set 
Preserve Mode)
2 - The ‘Configure all 
initialization settings and 
policies’ option in the 
Initialization options window 
will be selected. (Set 
Configure Mode)

Default: Display the 
'Initialization Options' window

Registry Value Name: 
DefInitMode

Values: 
0 - Display the ‘Initialization 
Options’ window
1 - Set Preserve Mode
2 - Set Configure Mode

Default: 0

Cannot be set by 
command line 
installation.

Import Certificate Chain

Determines if the certificate 
chain is imported to the 
token

Setting Name: Import 
Certificate Chain

Values:

• Do not import

• Import

• User selects import 
behavior

Default: Do not import

Registry Value Name: 
ImportCertChain

Values:
0 - Do not import certificate 
chain
1 - Import certificate chain
2- User selects import 
behavior

Default: 0

Cannot be set by 
command line 
installation.
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CAPI Settings
The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\CAPI 
registry key.

NOTE: 
These settings also apply to the Key Storage Provider (KSP).

Description ADM File Setting Registry Value Command Line

Password Timeout

Defines the number of minutes 
the CAPI-required password is 
valid following the last logon 
activity

Note: 

• For iKey tokens - per token 
and per process.
In addition to this registry 
key, an unrelated Password 
Timeout value is written to 
every iKey token during 
manufacture. The shorter of 
these two Password 
Timeout values - the one on 
the token and the one in this 
registry key during 
initialization - is applied.

• For Java, CardOS, SafeNet 
Virtual Token - no 
token/process specificity. 
The attribute is taken from 
this registry key.

Setting Name: Password 
Timeout

Values: 
>=0
(0= No timeout)

Default: 0

Registry Value Name: 
PasswordTimeout

Values: 
>=0
(0= No timeout)

Default: 0

Cannot be set by 
command line 
installation.

Logout Mode

Determines if the user is 
prompted to enter a password 
for each operation requiring 
the user to be logged on.

Setting Name: Logout Mode

Values:
Selected - A password prompt 
is displayed for each operation
Not selected - The user 
remains logged on after the first 
logon

Default: Not Selected

Registry Value Name: 
LogoutMode

Values:
1 (True) - A password prompt 
is displayed for each operation
0 (False)- The user remains 
logged on after the first logon

Default: 0

Cannot be set by 
command line 
installation.
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ASCII Password

Determines if non-ASCII 
characters are supported in 
Token Passwords, enabling a 
string containing non-ASCII 
characters to be used as a 
smart card logon password.

Setting Name: ASCII Password 

Values:
Selected - Non ASCII character 
are supported
Not selected -Only ASCII 
characters are supported

Default: Not selected

Registry Value Name: 
AsciiPassword

Values:
1 (True) - Non ASCII character 
are supported
0 (False)- Non ASCII 
characters are not supported

Default: 0(False)

Cannot be set by 
command line 
installation.

Overwrite Default Certificate

Determines if the default 
certificate selection can be 
reset after being explicitly set 
in legacy eToken PKI Client 
3.65

Setting Name: Overwrite 
Default Certificate

Values:
Selected -Default certificate can 
be reset
Not selected - Default 
certificate cannot be reset

Default: Not selected

Registry Value Name: 
OverwriteDefaultCertificate

Values:
1 - Default certificate can be 
reset
0 - Default certificate cannot be 
reset

Default: 0

Cannot be set by 
command line 
installation.

Sign Padding On-Board

Determines if sign padding is 
performed on-board supported 
devices for added security.
Sign padding is supported by 
Java tokens.

Note: To use this feature, 
SafeNet Authentication Client 
8.1 or later must be installed.

Setting Name: Sign Padding 
On-Board

Values:

• Not supported - Sign padding 
is always performed on the 
host computer

• Supported (backwardly 
compatible) - Sign padding is 
performed on-board 
supported devices when 
running SafeNet 
Authentication Client 8.1 or 
later;

Sign padding is performed on 
the host computer when 
running SafeNet Authentica-
tion Client versions earlier 
than 8.1

• Required - Sign padding is 
always performed on-board 
supported devices;

Not backwardly compatible 
with SafeNet Authentication 
Client versions earlier than 
8.1

Default: Not supported

Registry Value Name: 
SignPaddingOnBoard

Values:
0 - Not supported:
Sign padding is always 
performed on the host 
computer
1 - Supported:
Sign padding is performed on-
board supported devices when 
running SafeNet 
Authentication Client 8.1 or 
later;
Sign padding is performed on 
the host computer when 
running SafeNet 
Authentication Client versions 
earlier than 8.1
2- Required:
Sign padding is always 
performed on-board supported 
devices;
Not backwardly compatible 
with SafeNet Authentication 
Client versions earlier than 8.1

Default: 0

Cannot be set by 
command line 
installation.
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Internet Explorer Settings

The following settings are written to the appropriate folder’s 
SafeNet\Authentication\SAC\CAPI\IEXPLORE.EXE registry key. They apply when using Internet Explorer 
only. The values are set per process on a per machine basis.

Description ADM File Setting Registry Value  Command Line

No Default Key Container

Determines if the latest Default 
Key Container certificate on the 
user's token is ignored when a 
new certificate is enrolled on 
the token.

This feature relates to the 
scrdenrl.dll ActiveX control 
used by the Microsoft CA web 
site and the SafeNet 
Authentication Client.

Note: If the "Enrollment on 
Behalf" certificate used for 
enrollment is stored on an 
administrator token and not on 
a computer, this value must be 
0.

Setting Name:
No Default Key Container

Values:
Selected - The latest 
Default Key Container 
certificate on the user's 
token is ignored when a 
new certificate is enrolled 
on the token
Not selected - The latest 
Default Key Container 
certificate on the user's 
token is deleted when a 
new certificate is enrolled 
on the token

Default: Selected, for the 
IEXPLORE.EXE process 
only

Registry Value Name: 
NoDefaultKeyContainer

Values:
1 (True)- The latest Default 
Key Container certificate on 
the user's token is ignored 
when a new certificate is 
enrolled on the token
0 (False) - The latest Default 
Key Container certificate on 
the user's token is deleted 
when a new certificate is 
enrolled on the token

Default: 1 (True), for the 
IEXPLORE.EXE process only

PROP_EXPLORER_
DEFENROL

Default Enrollment Type

Determines if the administrator 
token's latest Enrollment Agent 
certificate must be the 
certificate used to enroll a new 
certificate on the user's token.

This feature applies when 
"Enrollment on Behalf" uses a 
certificate on an administrator 
token and not on a computer.

Note: To enable the token con-
taining the "Enrollment on 
Behalf" certificate to contain 
Smartcard Logon certificates 
also, this value must be 1.

This feature cannot be set 
in the GPO Editor or MMC

Registry Value Name: 
DefEnrollType

Values:
1 (True) - The administrator 
token's latest Enrollment 
Agent certificate is used, 
even if the token's Default 
Key Container contains a 
different type of certificate, 
such as Smartcard Logon
0 (False) - Regardless of its 
certificate type, the 
administrator token's Default 
Key Container certificate is 
used

Default: 0 (False), for the 
IEXPLORE.EXE process only

Cannot be set by 
command line 
installation, so must 
be added manually
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Certificate Store Settings

The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\CertStore 
registry key.

Microsoft Certificate Propagation Service
Windows Vista and later include the Microsoft Certificate Propagation Service. 
This duplicates some of the features of the SafeNet Authentication Client 
propagation functionality. To avoid a lack of synchronization between these 
different propagation processes, we strongly recommend closing the Microsoft 
Certificate Propagation Service and using only SafeNet Authentication Client for 
certificate propagation.

Description ADM File Setting Registry Value  Command Line

Propagate User 
Certificates

 Determines if all user 
certificates on the token are 
exported to the user 
store.

Note: Can be set in SafeNet 
Authentication Client Tools.

Setting Name: Propagate 
User Certificates

Values:
Selected -User certificates 
are exported
Not selected - User 
certificates are not exported

Default: Selected

Registry Value Name: 
PropagateUserCertificates
Values:
1 (True) - User certificates are 
exported
0 (False) - User certificates are 
not exported

Default: 1 (True)

PROP_PROPAGAT
EUSERCER

Propagate CA Certificates

Determines if all CA 
certificates on the token are 
exported to the Trusted CA 
store.

Note: Can be set in SafeNet 
Authentication Client Tools.

Setting Name: Propagate CA 
Certificates

Values:
Selected - CA certificates are 
exported
Not selected - CA certificates 
are not exported

Default: Selected

Registry Value Name: 
PropagateCACertificates

Values:
1 (True)- CA certificates are 
exported
0 (False)- CA certificates are 
not exported

Default: 1 (True)

PROP_PROPAGAT
ECACER

Synchronize Store

Determines if store 
synchronization is enabled.

The synchronize store is part 
of the SAC Monitor 
application. It synchronizes 
between the contents of the 
token and the SAC 
application. For example, if 
so configured, when the 
token is connected the token 
certificate is propagated to 
the certificate store, and 
removed when the token is 
disconnected.

Setting Name: Synchronize 
Store

Values:
Selected -Enabled
Not selected -Disabled

Default: Selected

Registry Value Name: 
SynchronizeStore

Values:
1 (True)-Enabled
0 (False) -Disabled

Default: 1 (True)

Cannot be set by 
command line 
installation.
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Add New Certificates to 
Token

 When a certificate with 
exportable keys is added to 
the user store, determines if 
an option is displayed to 
import that certificate to the 
selected token.

Setting Name: Add New 
Certificates to Token

Values:
Selected - An option is 
displayed to import the new 
certificate
Not selected - An option is 
not displayed to import the 
new certificate

Default: Selected

Registry Value Name: 
AddToTokenOnNewCertInStor
e

Values:
1 (True) - An option is 
displayed to import the new 
certificate
0 (False) - An option is not 
displayed to import the new 
certificate

Default: 1 (True)

Cannot be set by 
command line 
installation.

Remove User Certificates 
upon Token Disconnect

When a token is 
disconnected, determines if 
the user certificates that 
were exported from it are 
removed from the user store.

Setting Name: Remove User 
Certificates upon Token 
Disconnect

Values:
Selected - User certificates 
are removed from the user 
store
Not selected - User 
certificates are not removed 
from the user store

Default: Selected

Registry Value Name: 
RemoveUserCertsOnTokenRe
move

Values:
1 (True) - User certificates are 
removed from the user store
0 (False) - User certificates are 
not removed from the user 
store

Default: 1 (True)

Cannot be set by 
command line 
installation.

Remove Certificates from 
Store upon Token 
Disconnect

When an exported certificate 
is removed from the token, 
determines if that certificate 
is removed from the user 
store.

Setting Name: Remove 
Certificates upon Removal 
from Token

Values:
Selected - The certificate is 
removed from the user store
Not selected - The certificate 
is not removed from the user 
store

Default: Selected

Registry Value Name: 
RemoveFromStoreOnRemove
FromToken

Values:
1 (True) - The certificate is 
removed from the user store
0 (False) - The certificate is not 
removed from the user store

Default: 1 (True)

Cannot be set by 
command line 
installation.
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Remove Certificates from 
Token upon Removal from 
Store

When an exported certificate 
is removed from the user 
store, determines if an option 
is displayed to remove that 
certificate from the token.

Setting Name:
Remove Certificates from 
Token upon Removal from 
Store

Values:
Never - an option is not 
displayed to remove the 
certificate
Always - an option is 
displayed to remove the 
certificate
Template dependent - an 
option is displayed to remove 
only those certificates whose 
templates are listed in 
“Certificate Templates to 
Remove from Token” setting.

Default: Never

Registry Value Name: 
RemoveFromTokenOnRemove
FromStore

Values:
0 - Never; an option is not 
displayed to remove the 
certificate
1 - Always; an option is 
displayed to remove the 
certificate
2 - An option is displayed to 
remove only those certificates 
whose templates are listed in 
the registry setting 
RemoveFromStoreOnRemove
FromToken Templates.

Default: 0

Cannot be set by 
command line 
installation.

Certificate Templates to 
Remove from Token

Lists templates of the 
certificates that can be 
removed from a token when 
the exported certificates are 
removed from the user store.

Setting Name: Certificate 
Templates to Remove from 
Token

Values:
Template names, separated 
by commas

Default: None

Applies only when the 
Remove Certificates from 
Token upon Removal from 
Store setting is set to 
Template dependent.

Registry Value Name: 
RemoveFromTokenOnRemove
FromStoreTemplates

Values:
Template names, separated by 
commas

Default: None

Applies only when the registry 
setting 
RemoveFromTokenOnRemove
FromStore is set to 2.

Cannot be set by 
command line 
installation.

Certificate Removal Period

When an exported certificate 
is removed from the user 
store, defines the number of 
days to attempt to remove 
that certificate from a token 
that is not connected

Relevant only when the 
setting Remove Certificates 
from Token upon Removal 
from Store 
(RemoveFromTokenOnRem
oveFromStore) is set to 
Always or Template 
dependent.

Setting Name: Certificate 
Removal Period

Values:
>=0

Default: 
7

Registry Value Name: 
CertsToRemoveStorePeriod

Values:
>=0

Default: 
7

Cannot be set by 
command line 
installation.

Description (Cont.) ADM File Setting (Cont.) Registry Value  (Cont.)  Command Line 
SafeNet Authentication Client 10.5 (GA) Administrator Guide
Document Number: 007-013560-005, Revision A

97



8 – Configuration Properties
CNG Key Storage Provider Settings

The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\CNG registry key.

Delete Original Key After 
Copy

When a key and its 
certificate are copied from 
the certificate store to a 
token, determines if the 
private key is deleted from 
the source CSP.

Setting Name: Delete 
Original Key After Copy

Values:
Selected - Key is deleted from 
the CSP
Not selected - Key is retained 
in the CSP

Default: Selected

Registry Value Name: 
DeleteOriginalKeyAfterCopy

Values:
1 (True) - Key is deleted from 
the CSP
0 (False) - Key is retained in 
the CSP

Default: 1 (True)

Cannot be set by 
command line 
installation.

Calculates the Certificate 
Friendly Name if it does 
not exist.

Setting Name: Calculate 
Certificate Friendly Name

Values:
Selected - Calculate friendly 
name using other certificate 
attributes
Not selected - Does not 
calculate friendly name

Default: Not Selected

Registry Value Name: 
CalculateCertFriendlyName

Values:
1 (True) - Calculate Friendly 
Name
0 (False) - Do not calculate 
Friendly Name

Default: 0 (False)

Note: If the Value=1, and the 
friendly name is manually set, 
the calculated friendly name 
will be applied.

Cannot be set by 
command line 
installation.

NOTE: 
These settings apply to the Key Storage Provider (KSP) only.

Description Settings in GPO Editor or 
MMC

Registry Key  Command Line

Cryptographic Provider

Determines which 
cryptographic provider to use 
for certificate propagation.

Note: Can be set in SafeNet 
Authentication Client Tools.

Note: After changing the 
cryptographic provider 
setting, reconnect the token 
to ensure that the properties 
are updated to the token.

Note: This setting is not 
relevant to IDPrime MD 
cards.

Setting Name: 
Cryptographic Provider

Values:
0 = CSP
1 = KSP (if supported by 
the OS)
2 = The Provider that 
enrolled the certificate 
(This information is stored 
on the token)

Default: 2

Registry Value Name: 
KspPropagationMode

Values:
0 = CSP
1 = KSP (if supported by 
the OS)
2 = The Provider that 
enrolled the certificate 
(This information is stored 
on the token)

Default: 2

KSP_ENABLED

Enables you to prevent 
KSP from being installed.
See "KSP_ENABLED" on 
page 45.
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Token Password Quality Settings

The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\PQ registry key.

NOTE: 
These settings are not relevant to IDPrime MD cards, as the password quality settings reside on the 
card itself.

Description Settings in GPO Editor 
or MMC

Registry Key  Command Line

Password - Minimum 
Length

Defines the minimum 
password length.

Note: Can be set in SafeNet 
Authentication Client Tools.

Setting Name: 
Password -Minimum 
Length

Values:
>=4

Default: 6

Registry Key Name: 
pqMinLen

Values:
>=4

Default: 6

PROP_PQ_MINLEN

Password - Maximum 
Length

Defines the maximum 
password length.

Note: Can be set in SafeNet 
Authentication Client Tools.

Setting Name: 
Password -Maximum 
Length

Values:
Cannot be less than the 
Password Minimum 
Length

Default: 16

Registry Key Name: 
pqMaxLen

Values:
Cannot be less than the 
Password Minimum Length

Default: 16

Cannot be set by 
command line installation.

Password -  Maximum 
Usage Period

Defines the maximum 
number of days a password 
is valid.

Note: Can be set in SafeNet 
Authentication Client Tools.

Note: This parameter is ‘Day 
Sensitive’ i.e. the system 
counts the day’s and not the 
hour in which the user made 
the change.

Setting Name: 
Password - Maximum 
Usage Period

Values:
>=0
(0 =No expiration)

Default: 0 

Registry Key Name: 
pqMaxAge

Values:
>=0
(0 =No expiration)

Default: 0

PROP_PQ_MAXAGE

Password - Minimum 
Usage Period

Defines the minimum 
number of days between 
password changes.

Note: Can be set in SafeNet 
Authentication Client Tools.

Note: Does not apply to iKey 
devices.

Setting Name: 
Password - Minimum 
Usage Period

Values:
>=0
(0 = No minimum)

Default: 0

Registry Key Name: 
pqMinAge

Values:
>=0
(0 = No minimum)

Default: 0

PROP_PQ_MINAGE
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Password - Expiration 
Warning Period

Defines the number of days 
before expiration during 
which a warning is 
displayed.

Note: Can be set in SafeNet 
Authentication Client Tools.

Setting Name: 
Password - Expiration 
Warning Period

Values:
>=0
(0 = No warning)

Default: 0 

Registry Key Name: 
pqWarnPeriod

Values:
>=0
(0 = No warning)

Default: 0 

PROP_PQ_WARNPERIO
D

Password - History Size

Defines the number of 
recent passwords that must 
not be repeated.

Note: Can be set in SafeNet 
Authentication Client Tools.

Setting Name: 
Password - History Size

Values:
>= 0
(0 = No minimum) 

Default: 10

Registry Key Name: 
pqHistorySize

Values:
>= 0
(0 = No minimum) 

Default: 10
(iKey device history is limited 
to 6)

PROP_PQ_HISTORYSIZ
E

Password - Maximum 
Consecutive Repetitions

Defines the maximum 
number of consecutive times 
a character can be used in a 
password.

Note: Can be set in SafeNet 
Authentication Client Tools.

Note: Does not apply to iKey 
devices.

Setting Name: 
Password - Maximum 
Consecutive Repetitions

Values:
0 - 16
(0 = No maximum)

Default: 3

Registry Key Name: 
pqMaxRepeated

Values:
0 - 16
(0 = No maximum)

Default: 3

Cannot be set by 
command line installation.

Password - Complexity

Determines if there is a 
minimum number of 
character types that must be 
included in a new Token 
Password
The character types are: 
upper-case letters, lower-
case letters, numerals, and 
special characters.

Note: Can be set in SafeNet 
Authentication Client Tools.

Setting Name: 
Password - Complexity

Values:
Standard complexity - 
A minimum of 2 or 3 
types must be included, 
as defined in the 
Password- Minimum 
Mixed Character Types 
setting
Manual complexity -
The rule for each 
character type is defined 
in the character type's 
Include setting

Default: Standard 
complexity

Registry Key Name: 
pqMixChars

Values:
1 - A minimum of 2 or 3 types 
must be included, as defined 
in the Password- Minimum 
Mixed Character Types 
setting
0 -The rule for each character 
type is defined in the 
character type's Include 
setting

Default: 1

PROP_PQ_MIXCHARS

Description (Cont.) Settings in GPO Editor 
or MMC (Cont.)

Registry Key  (Cont.)  Command Line (Cont.)
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Password - Minimum 
Mixed Character Types

Defines the minimum 
number of character types 
that must be included in a 
new Token Password.
The character types are: 
upper-case letters, lower-
case letters, numerals, and 
special characters.

Note: 

• Applies only when the 
Password - Complexity 
setting is set to Standard 
complexity.

• Can be set in SafeNet 
Authentication Client 
Tools.

Setting Name: 
Password - Minimum 
Mixed Character Types

Values:
At least 3 character 
types
At least 2 character 
types

Default: At least 3 
character types

Registry Key Name: 
pqMixLevel

Values:
0 - At least 3 character types
1 - At least 2 character types

Default:0

Cannot be set by 
command line installation

Password - Include 
Numerals

Determines if the password 
can include numerals.

Note: 

• Applies only when the 
Password - Complexity 
setting is set to Manual 
complexity.

• Can be set in SafeNet 
Authentication Client 
Tools.

Setting Name: 
Password - Include 
Numerals

Values:
Permitted
Forbidden
Mandatory

Default: Permitted

Note: 

Forbidden is not 
supported by iKey 
devices.

Registry Key Name: 
pqNumbers

Values:
0 -Permitted
1 - Forbidden
2 - Mandatory

Default: 0

Cannot be set by 
command line installation

Password - Include Upper-
Case

Determines if the password 
can include upper-case 
letters.

Note: 

• Applies only when the 
Password - Complexity 
setting is set to Manual 
complexity.

• Can be set in SafeNet 
Authentication Client 
Tools.

Setting Name: 
Password - Include 
Upper-Case

Values:
Permitted
Forbidden
Mandatory

Default: Permitted

Registry Key Name: 
pqUpperCase

Values:

0 - Permitted
1 - Forbidden
2 - Mandatory

Default: 0

Cannot be set by 
command line installation.

Description (Cont.) Settings in GPO Editor 
or MMC (Cont.)

Registry Key  (Cont.)  Command Line (Cont.)
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Password - Include Lower-
Case

Determines if the password 
can include lower-case 
letters.

Note: 

• Applies only when the 
Password - Complexity 
setting is set to Manual 
complexity.

• Can be set in SafeNet 
Authentication Client 
Tools.

Setting Name: 
Password - Include 
Lower - Case

Values:
Permitted
Forbidden
Mandatory

Default: Permitted

Registry Key Name: 
pqLowerCase

Values:
0 - Permitted
1 - Forbidden
2 - Mandatory

Default: 0

Cannot be set by 
command line installation.

Password - Include 
Special Characters

Determines if the password 
can include special 
characters, such as @,!, &.

Note: 

• Applies only when the 
Password - Complexity 
setting is set to Manual 
complexity.

• Can be set in SafeNet 
Authentication Client 
Tools.

Setting Name: 
Password - Include 
Special Characters

Values:
Permitted
Forbidden
Mandatory

Default: Permitted

Registry Key Name: 
pqSpecial

Values:
0 - Permitted
1 - Forbidden
2 - Mandatory

Default: 0

Cannot be set by 
command line installation.

Password Quality Check 
on Initialization

Determines if the password 
quality settings are checked 
and enforced 
 when a token is initialized

Note: 

We recommend that this 
policy not be set when 
tokens are enrolled using 
SafeNet Authentication 
Manager.

Setting Name: 
Password Quality Check 
on Initialization

Values:
Selected -The password 
quality is enforced
Not selected - The 
password quality is not 
enforced

Default: Not selected

Registry Key Name: 
pqCheckInit

Values:
1 (True) -The password 
quality is enforced
0 (False) - The password 
quality is not enforced

Default: 0

Cannot be set by 
command line installation.

Description (Cont.) Settings in GPO Editor 
or MMC (Cont.)

Registry Key  (Cont.)  Command Line (Cont.)
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Password Quality Owner

Defines the owner of the 
password quality settings on 
a re initialized token, and 
defines the default of the 
Password Quality Modifiable 
setting.

Setting Name: 
Password Quality Owner

Values:
Administrator
User

Default: 
Administrator, for tokens 
with an Administrator 
Password.
User, for tokens without 
an Administrator 
Password.

Registry Key Name: 
pqOwner

Values:
0 - Administrator
1 - User

Default: 
0, for tokens with an 
Administrator Password.
1, for tokens without an 
Administrator Password.

Cannot be set by 
command line installation.

Enable Password Quality 
Modification

Determines if the password 
quality settings on a newly 
initialized token 
can be modified by the 
owner.

See the Password Quality 
Owner setting.

Setting Name: Enable 
Password Quality 
Modification.

Values:
Selected - The 
password quality can be 
modified by the owner
Not selected - The 
password quality cannot 
be modified by the owner

Default:
Selected, for 
administrator-owned 
tokens
Not selected, for user 
owned tokens.

Registry Key Name: 
pqModifiable

Values:
1 (True)- The password 
quality can be modified by the 
owner
0 (False) - The password 
quality cannot be modified by 
the owner

Default: 
1 (True), for administrator-
owned tokens
0 (False), for user owned 
tokens.

Cannot be set by 
command line installation.

Description (Cont.) Settings in GPO Editor 
or MMC (Cont.)

Registry Key  (Cont.)  Command Line (Cont.)
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Enable Administrator 
Password Quality Check

Determines if the 
Administrator Password 
Quality Check is enabled.

When enabled, this property 
enforces an administrator 
(SO) password (on eToken 
and IDPrime devices) that 
has at least 3 different 
character types and a 
minimum length of 8 
characters.

The character types are: 
upper-case letters, lower-
case letters, numerals, and 
special characters.

Note: For backward 
compatibility on IDPrime 
devices, the Administrator 
Key can be used with 48 
hexadecimal characters via 
the UI and/or 24 binary bytes 
via the API call.

When disabled, the old 
behavior is as follows:
eToken: minimum of 4 
characters and no minimum 
character type enforcement
IDPrime: minimum of 8 
characters and no minimum 
character type enforcement, 
or the administrator key can 
be used.

Note: When the ITI 
Certification mode property 
is enabled, the Enable 
Administrator Password 
Quality Check property will 
be disabled 

Setting Name: Enable 
Administrator Password 
Quality Check

Values:

Selected - Administrator 
Password Quality is 
enforced

Not Selected - 
Administrator Password 
Quality is disabled

Default: Selected

Registry Key Name: 
pqAdminPQ

Values:

1 (Enabled) - Administrator 
Password Quality is enforced

0 (Disabled) - Administrator 
Password Quality is disabled

Default: Enabled

Cannot be set by 
command line installation.

Description (Cont.) Settings in GPO Editor 
or MMC (Cont.)

Registry Key  (Cont.)  Command Line (Cont.)
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SafeNet Authentication Client Tools UI Access Control List
The Access Control Properties window contains a list of settings that determine which features are enabled in the 
SafeNet Authentication Client Tools and Tray Menu.

The following settings are written to the appropriate folder’s 
SafeNet\Authentication\SAC\AccessControl registry key.

In the following table, the Access Control Feature column displays the name in the Access Control Properties 
window.

Access Control Feature ADM File Setting Registry Key  Command Line

All access control features 
listed below

Values:

Selected - The feature is 
enabled
Not selected - The 
feature is disabled.

Default: Selected, 
except where indicated 
in the table

Values:

1 (True) - The feature is 
enabled.
0 (False) - The feature is 
disabled.

Default: 1(True), except 
where indicated in the table

Cannot be set by 
command line installation.

NOTE: 
All access control features are enabled by default, except where indicated in the table.

Access Control Feature Registry Value Name Description

Rename Token RenameToken Enables/Disables the Rename Token feature in SafeNet 
Authentication Client Tools.

Change Token Password ChangePassword Enables/Disables the Change Token Password feature in 
SafeNet Authentication Client Tools.

Unlock Token UnlockEtoken Enables/Disables the Unlock Token feature in SafeNet 
Authentication Client Tools.
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Delete Token Content ClearEToken Enables/Disables the Delete Token Content feature in 
SafeNet Authentication Client Tools.

View Token Information ViewTokenInfo Enables/Disables the View Token Information feature in 
SafeNet Authentication Client Tools.

Disconnect SafeNet 
Virtual Token

DisconnectVirtual Enables/Disables the Disconnect SafeNet Virtual Token 
feature in SafeNet Authentication Client Tools.

Help ShowHelp Determines if the user can open the Help file in SafeNet 
Authentication Client Tools.

Advanced View OpenAdvancedView Determines if the user can open the Advanced View in 
SafeNet Authentication Client Tools.

Reader Settings ManageReaders Enables/Disables the Reader Settings feature in SafeNet 
Authentication Client Tools.

Connect SafeNet Virtual 
Token

AddeTokenVirtual Enables/Disables the Connect SafeNet Virtual Token 
feature in SafeNet Authentication Client Tools.

Initialize Token InitializeEToken Enables/Disables the Initialize Token feature in SafeNet 
Authentication Client Tools.

Import Certificate ImportCertificate Enables/Disables the Import Certificate feature in SafeNet 
Authentication Client Tools.

Reset Default Certificate 
Selection

ClearDefaultCert Enables/Disables the Reset Default Certificate Selection 
feature in SafeNet Authentication Client Tools.

Delete Certificate DeleteCertificate Enables/Disables the Delete Certificate feature in SafeNet 
Authentication ClientTools.

Export Certificate ExportCertificate Enables/Disables the Export Certificate feature in SafeNet 
Authentication Client Tools.

Set Certificate as Default SetCertificateAsDefault Enables/Disables the Set Certificate as Default feature in 
SafeNet Authentication Client Tools.

Log On as Administrator LoginAsAdministrator Enables/Disables the Log On as Administrator feature in 
SafeNet Authentication Client Tools.

Change Administrator 
Password

ChangeAdministratorPasswor
d

Enables/Disables the Change Administrator Password 
feature in SafeNet Authentication Client Tools.

Set Token Password SetUserPassword Enables/Disables the Set Token Password feature in 
SafeNet Authentication Client Tools.

Token Password Retries AllowChangeUserMaxRetry Enables/Disables the Logon retries before token is locked 
feature (for the Token Password) in SafeNet 
Authentication Client Tools.

Administrator Password 
Retries

AllowChangeAdminMaxRetry Enables/Disables the Logon retries before token is locked 
feature (for the Administrator Password) in SafeNet 
Authentication Client Tools.

Advanced Initialization 
Settings

OpenAdvancedModeOfInitializ
e

Enables/Disables the Advanced button in the Token 
Initialization window in SafeNet Authentication Client 
Tools.

Access Control Feature Registry Value Name (Cont.) Description (Cont.)
SafeNet Authentication Client 10.5 (GA) Administrator Guide
Document Number: 007-013560-005, Revision A

106



8 – Configuration Properties
System Tray - Unlock 
Token

TrayIconUnlockEtoken Enables/Disables the Unlock Token feature in the SafeNet 
Authentication Client Tray Menu

System Tray - Generate 
OTP

GenerateOTP Enables/Disables the Generate OTP feature in the 
SafeNet Authentication Client Tray Menu

System Tray - Delete 
Token Content

TrayIconClearEToken Enables/Disables the Delete Token Content feature in the 
SafeNet Authentication Client Tray Menu. 

Note: By default, this feature is Disabled

System Tray -Change 
Token Password

TrayIconChangePassword Enables/Disables the Change Token Password feature in 
the SafeNet Authentication Client Tray Menu.

System Tray -Synchronize 
Domain-Token Passwords

SyncDomainAndTokenPass Enables/Disables the Synchronize Domain Token 
Passwords feature in the SafeNet Authentication Client 
Tray Menu.

System Tray - Tools OpeneTokenProperties Enables/Disables the Tools menu item (open SafeNet 
Authentication Client Tools) in the SafeNet Authentication 
Client Tray Menu.

System Tray - About About Enables/Disables the About menu item in the SafeNet 
Authentication Client Tray Menu.

Enable Change IdenTrust 
Identity 

IdentrusChangePassword Enables/Disables the Change IdenTrust PIN feature in 
SafeNet Authentication Client Tools.

Enable Unblock IdenTrust 
Passcode

IdentrusUnlock Enables/Disables the Unlock IdenTrust feature in SafeNet 
Authentication Client Tools.

Delete Data Object DeleteDataObject Enables/Disables the Delete Data Object feature in 
SafeNet Authentication Client Tools.

Allow One Factor AllowOneFactor Enables/Disables the Allow One Factor feature in the 
Advanced Token Initialization Settings window in SafeNet 
Authentication Client Tools.

Note: This property 
cannot be set in the 
Access Control Proper-
ties window. It must be 
set in the registry key.

VerisignSerialNumber Enables/Disables the Verisign Serial number feature in 
SafeNet Authentication Client Tools.

PIN Type PinType  Defines which GUI PIN Properties are enabled/disabled 
in SAC Tools 'Advanced' PIN Properties tab and the 
'Initialization' window.PIN Purpose PinPurpose

Cache Type PinCacheType 

Cache Timeout PinCacheInfo 

PIN Flags PinFlags

Ext. PIN Flags PinFlagsEx

Validity period (days) PinValidity

Expiration warning period 
(days)

PinWarning 

Access Control Feature Registry Value Name (Cont.) Description (Cont.)
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Minimum length 
(characters)

PinMinLen Defines which GUI PIN Quality parameters are 
enabled/disabled in SAC Tools 'Advanced' tab and the 
'Initialization' window.

Maximum length 
(characters)

PinMaxLen

History size PinHistory

Number of different 
characters that can be 
repeated at least once

PinNumDiffCharRepeat

Maximum number a 
characters can appear

PinMaxNumCharAppear 

Maximum number of 
characters in a sequence

PinMaxNumCharSequence

Maximum number a 
character can be repeated 
in adjacent positions

PinMaxNumCharRepeatPos

Numeric PinNumber

Alpha Upper PinUpper

Alpha Lower PinLower

Non alpha PinSpecial

Alpha PinAlphabetic

Non Ascii PinNonAlphabetic

Minimum usage period 
(days)

PinMinUse

Maximum usage period 
(days)

PinMaxUse

Must meet complexity 
requirements

PinComplexity

Maximum consecutive 
repetitions

PinMaxRepeat

Access Control Feature Registry Value Name (Cont.) Description (Cont.)
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Security Settings
The following settings are written to the appropriate folder’s SafeNet\Authentication\SAC\Crypto registry 
key.

Description ADM File Setting Registry Value  Command Line

Deprecated 
Cryptographic Algorithms 
and Features 

The default list of 
deprecated cryptographic 
algorithms and features 
may be enhanced in order 
to comply with NIST 
requirements in future 
versions. It is up to the 
customer to check that it will 
be compatible with third-
party applications.

Setting Name:
Deprecated Cryptographic 
Algorithms and Features 

Values:

None - All SAC cryptographic
algorithms and features are
supported. This was the default 
value for SAC versions below 
10.5. Setting this value will 
cause SAC to be compatible 
with SAC 10.5 and below. It is 
strongly recommended to read 
SAC Configuration 
Recommendations on page 15 
before applying legacy values.

Obsolete - A list of restricted 
and deprecated cryptographic 
algorithms and features.
The following are deprecated:
MD5, RC2, RC4, DES, 2DES, 
GenericSecret<112, RSA-RAW, 
RSA<2048, ECC<224, ECB, 
Sign-SHA1

Manual - Create your own list of 
deprecated algorithms and 
features. (See the description 
below).

Default: Obsolete

Value Name: Disable-Crypto
Values: (String)

None - All SAC cryptographic
algorithms and features are
supported. This was the default 
value for SAC versions below 
10.5. Setting this value will 
cause SAC to be compatible with 
SAC 10.5 and below. It is 
strongly recommended to read 
SAC Configuration 
Recommendations on page 15 
before applying legacy values.

Obsolete - A list of restricted 
and deprecated cryptographic 
algorithms and features.
The following are deprecated:
MD5, RC2, RC4, DES, 2DES, 
GenericSecret<112, RSA-RAW, 
RSA<2048, ECC<224, ECB, 
Sign-SHA1

Manual - Create your own list of 
deprecated algorithms and 
features. (See the description 
below).

Default: Obsolete

Cannot be set by 
command line 
installation.

The following can be disabled:
Algorithms: RSA, ECC, DES, 2DES, 3DES, AES, RC2, RC4, GenericSecret
Hash types: MD5, SHA1, SHA2
Padding types: RAW, PKCS1, OAEP, PSS
Cipher modes: ECB, CBC, CTR, CCM
Mechanisms: MAC, HMAC, ECDSA, ECDH
Operations: Encrypt, Decrypt, Sign, Verify, Generate, Derive, Wrap, Unwrap, Digest, Create (keys only)
Weak key size: RSA<2048
Object types: HWEF – elementary file (EF) objects (used by eToken devices for storing exportable symmetric keys

and symmetric keys without on-board implementation)
HWALL – all types of objects implemented on token (Base Security Object (BSO) and EF),
ETV – eToken Virtual

Example of a manual configuration: Encrypt-DES-ECB, Sign-3DES-MAC, DES-CTR, HMAC-MD5, HMAC-SHA1, 
HMAC-SHA2, DES-CBC, Unwrap-DES-ECB, RSA-PKCS1-MD5, Verify-RSAPSS-SHA2, AES-CTR, AES-MAC, 
Decrypt-RC2, Wrap-ECB.
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Key Management

Defines key creation, 
export, unwrap, and off-
board crypto policies.

SAC default behavior may 
be updated in future 
versions in order to comply 
with NIST requirements.
It is up to the customer to 
check that it will be 
compatible with third-party 
applications. 

Setting Name:
Key Management 

Values: (String)

Compatible - enables the use 
of features that are deprecated 
in the Optimized and Strict 
configurations below. This was 
the default value for SAC 
versions below 10.5. Setting this 
value will cause SAC to be 
compatible with SAC 10.5 and 
below. It is strongly 
recommended to read SAC 
Configuration 
Recommendations on page 15 
before applying legacy values.

Optimized:
Disable the generation or 
creation of exportable keys.
Disable the exporting of keys, 
regardless of how they were 
generated.
Disable any usage of symmetric 
keys off-board including unwrap.
Disable the unwrap-PKCS1.5 
and unwrap-AES-CBC on 
hardware tokens (session 
enable).

Strict:
Disable the generation or 
creation of exportable keys.
Disable the exporting of keys, 
regardless of how they were 
generated.
Disable any usage of symmetric 
keys off-board including unwrap.
Disable all unwrap-PKCS1.5 
and unwrap-AES-CBC 
operations.

Default: Optimized

Registry Value Name:
Key-Management-Security

Values: (String)

Compatible - enables the use of 
features that are deprecated in 
the Optimized and Strict 
configurations below. This was 
the default value for SAC 
versions below 10.5. Setting this 
value will cause SAC to be 
compatible with SAC 10.5 and 
below. It is strongly 
recommended to read SAC 
Configuration 
Recommendations on page 15 
before applying legacy values.

Optimized:
Disable the generation or 
creation of exportable keys.
Disable the exporting of keys, 
regardless of how they were 
generated.
Disable any usage of symmetric 
keys off-board including unwrap.
Disable the unwrap-PKCS1.5 
and unwrap-AES-CBC on 
hardware tokens (session 
enable).

Strict:
Disable the generation or 
creation of exportable keys.
Disable the exporting of keys, 
regardless of how they were 
generated.
Disable any usage of symmetric 
keys off-board including unwrap.
Disable all unwrap-PKCS1.5 and 
unwrap-AES-CBC operations.

Default: Optimized

Cannot be set by 
command line 
installation.

Description (Cont.) ADM File Setting (Cont.) Registry Value  (Cont.)  Command Line 
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DotNetOBKGType

This key enables the 
generation of the RSA 
keypairs using BCrypt API 
on the local computer 
instead of On Board Key 
Generation. If the value of 
this key is set to 0 or is 
absent (default installation), 
then the RSA keypairs on 
IDPrime.NET cards are 
generated using the 
standard On Board Key 
Generation mechanism. If 
this key is created and set 
to 1, the Minidriver creates 
the RSA keypairs using the 
BCrypt API on the local 
computer and keys are 
imported into the 
IDPrime.NET smart card.

Not Supported Setting Name:
DotNetOBKGType

Values:
0 = Generate on board (key pair)

1 (and above) = Key pair 
generation is done by software 
(that is: disable on board key 
generation)

Default: 0

Cannot be set by 
command line 
installation.

Description (Cont.) ADM File Setting (Cont.) Registry Value  (Cont.)  Command Line 
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Log Settings
The following settings are written to the appropriate folder’s 

SafeNet\Authentication\SAC\Log registry key.

These settings may be defined using:

HKEY_LOCAL_MACHINE or HKEY_CURRENT_USER

Description ADM File Setting Registry Value  Command Line

Enabled

Determines if the SafeNet 
Authentication Client Log 
feature is enabled.

Not supported Registry Value Name: Enabled

Value:
1 - Enabled
0 - Disabled

Default: 0 (Disabled)

Days

Defines the number of days 
log files will be saved from 
the time the log feature was 
enabled.

Not supported Registry Value Name: 
Days

Value:
Enter the number of days 
(numerical).

Default: 
1 day

MaxFileSize 

Defines the maximum size 
of an individual log file. 
Once the maximum fil size 
is reached, SAC removes 
older log records to allow 
saving newer log 
information.

Not supported Registry Value Name: 
MaxFileSize

Value:
Enter a value in Bytes.

Default: 2000000 (Bytes) 
(Approximately 2MB)

TotalMaxSizeMB 

Defines the total size of all 
the log files when in debug 
mode. (Megabytes).

Not supported Registry Value Name: 
TotalMaxSizeMB

Value:
Enter a value in Megabytes.

Default: 0 (Unlimited)

ManageTimeInterval 

Defines how often the 
TotalMaxSize parameter is 
checked to ensure the total 
maximum size has not been 
exceeded.

Not supported Registry Value Name: 
ManageTimeInterval

Value:
Enter a value in minutes 
(numerical).

Default: 60 minutes
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e following settings are written to the appropriate folder’s 

SafeNet\Authentication\SAC\General registry key.

These settings may be defined using:

HKEY_LOCAL_MACHINE or HKEY_CURRENT_USER

IdenTrust Settings

Description ADM File Setting Registry Value  Command Line

Override IdenTrust OIDs

Overrides SAC's list of 
IdenTrust OIDs

Note: 

Users must log on to their 
tokens whenever signing 
with a certificate defined as 
IdenTrust.

To avoid having to 
authenticate every time a 
cryptographic operation is 
required for certificates 
containing IdenTrust OID, 
and Entrust details, remove 
the OID value from the 
registration key value.

Setting name: Override 
IdenTrust OIDs

Value:The following settings 
are written to the appropriate 
folder’s 
SafeNet\Authentication
\SAC\Identrust registry 
key.

Empty

Default: No override

Registry Value Name: 
IdentrusIdentity

Value:
Empty

Default: No override

Cannot be set by 
command line 
installation.
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The following values are displayed in the SAC Tools interface. 

Serial Number (PKCS#11) and Card ID (Minidriver)
The SAC Tools interface displays values of token/card’s Serial Number (PKCS#11) and Card ID (Minidriver).

SAC calculates the Serial Number (PKCS#11) from the content of CardID EF (elementary file).

CardID EF 0x0201 (defined by Minidriver standard) – 16 bytes long, includes binary card serial, initialized during 
perso process.

The entire CardID value can be found in SAC Tools in the Card ID (Minidriver) field.

The following algorithm is used to calculate the PKCS#11 serial:

1. Hash the last 12 bytes from 16 bytes of CardID with MD5

2. The 8 high bytes of hash results convert to 16 printable hexadecimal chars

For example:

Content of CardID: 48 80 03 47 8a 9a 2c 72 48 80 03 47 8a 9a 2c 72 (16 bytes)

Input to hash function: 8a 9a 2c 72 48 80 03 47 8a 9a 2c 72 (12 bytes)

Output of hash function: db 61 58 9c 7d 1b 14 9f 0c 29 6c b2 23 e3 8e 75 (16 bytes)

Input to hexadecimal conversion function:  db 61 58 9c 7d 1b 14 9f (8 bytes)

Output of conversion function: 44 42 36 31 35 38 39 43 37 44 31 42 31 34 39 46 = 
"DB61589C7D1B149F" (16 bytes)

 

The Serial Number (PKCS#11) value can be achieved through PKCS#11 by using the standard C_GetTokenInfo 
function which will return the binary value of serial number.

To get the Card ID (Minidriver) value, SAC extended PKCS#11 ETCKA_CARD_ID is required (for more 
information isee the SAC SDK documentation, as this is part of SAC SDK package).

NOTE: 
• The calculation algorithm was inherited from Gemalto’s IDGo 800 and cannot be changed 

without breaking the backwards compatibility.
• The hexadecimal conversion function uses only capital letters
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